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实验一    控制系统应用软件学习使用 

及典型控制系统建模分析 

一、 实验目的 

1、了解 MATLAB 的强大功能、使用范围与特点，正确理解并掌握 MATLAB 的基本

知识、基本操作，为后续实验的顺利进行打好基础。 

2、掌握 SIMULINK的基本使用方法，了解应用 SIMULINK进行典型控制系统建模、

仿真、分析的过程，掌握基于 MATLAB/SIMULINK进行控制系统设计、分析与仿真的方法。 

二、 实验设备 

序号 仪器设备名称 数量 

1 计算机 1 

  2 MATLAB软件  1 

  3 打印机  1 

三、 实验要求 

1、必须进行实验预习，要求认真浏览实验内容，最好能够自己上机独立操作一遍。 

2、由于后续实验均以本实验为基础，因此实验一至关重要，认真学习

MATLAB/SIMULINK的基本使用方法。 

3、于实验学时有限，而本实验内容多，并且本实验所涉及的仅是 MATLAB/SIMULINK

的部分内容，所以要求同学们自学，利用课余时间学习 MATLAB/SIMULINK的相关知识。  

四、 实验内容与步骤 

注意： 

1、MATLAB中所有命令及表达式必须在英文状态下输入（汉字除外），而且 MATLAB

严格区分字母的大小写。 

2、所有命令都可通过 help来显示该命令的帮助信息，如 help sin(显示正弦函数

sin的帮助信息)。 

3、所有命令都必须以小写字母形式输入才能正确执行，否则出错。 
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第一部分        MATLAB入门 

（一） MATLAB的启动和退出 

启动：1．双击桌面上 MATLAB的快捷方式图标 即可。 

2．开始→程序→MATLAB6.5文件夹→单击 。 

退出：1、直接单击界面的关闭图标 即可退出 MATLAB。 

2．、选择菜单 File→Exit MATLAB。  

（二） MATLAB的操作界面 

正确安装 MATLAB 后，首次启动

MATLAB会出现图 1-1所示界面。这就是
MATLAB的缺省外貌。 

 
右图为 MATLAB6.5 的缺省外

形，界面上铺放着 4个最常用的窗口：
命令窗口（Command Window）、工作空
间（Workspace）、命令历史窗（Command 
History）和当前路径窗口（ Current 
Directory）。                                    图 1-1   MATLAB的操作界面 

（三） 命令窗口的基本操作命令 

1、窗口命令 

l close：该命令用于关闭当前的图形窗口。 

l close all：该命令用于关闭所有的图形窗口。 

l clc：该命令用于清除命令窗口中的内容，光标将回到窗口的左上角。 

l hold on: 不刷新当前窗口。 

l hold off: 刷新当前窗口。 

2、工作空间管理命令 

l who:该命令用于列出当前工作区间的所有变量。 

l whos：该命令用于列出当前工作区间的所有变量，并显示变量的大小、类型

及其占用的磁盘空间。 

l clear：该命令用于从工作区间清除所有的变量。 

3、系统帮助命令 
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l help:该命令用于在命令窗口中显示 MATLAB函数的帮助信息。 

l 如 help sin(显示三角函数 sin的帮助信息) 

（四） 变量 

1、变量的命名 

变量名必须以字母开头（不能超过 19个字符），之后可以是任意字母、数字或下划

线；变量名称区分字母的大小写；变量中不能包含有标点符号。 

变量的表达格式如下：变量=表达式 

在命令窗口状态下，输入的命令均存在于 workspace 工作空间中，只要输入 who

或者 whos即可看到工作空间中的变量。如果要清除变量，可用 clear命令。 

2、MATLAB所定义的特殊变量及其意义 

表 1-1    特殊变量 
变量名 意义 

ans 
用于结果的缺省变量名,最近的计算结果的变量名(即

answer的缩写) 

i或 j 基本虚数单位（即 1-） 

who 列出所有定义过的变量名称 

eps MATLAB定义的正的极小值=2.2204e-16 

pi 圆周率π值 3.14159265... 

inf ∞值，无限大，如 1/0 

NaN或 nan 非数（Not A Number）,如 0/0 

nargin 函数的输入变量个数 

nargout 函数的输出变量个数 

3、变量操作 

在命令窗口中，同时存储着输入的命令和创建的所有变量值，它们可以在任何需要

的时候被调用。如要察看变量 a的值，只需要在命令窗口中输入变量的名称即可：》a。 

4、例子： 

>> a=3+4i;b=2+3j; c=a+b; 
c = 
   5.0000 + 7.0000i 
>> d=a*b 
d = 
  -6.0000 +17.0000i 
>> whos 
  Name      Size                   Bytes  Class 
  a         1x1                  16  double array (complex) 
  b         1x1                  16  double array (complex) 
  c         1x1                  16  double array (complex) 
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  d         1x1                  16  double array (complex) 
Grand total is 4 elements using 64 bytes 

（五） 运算符 

1、算术运算符 

算术运算符是构成运算的最基本的操作指令，可在命令窗口中直接运行。 

表 1-2        算术运算符 

符号 意义 符号 意义 符号 意义 

+ 相加 ^ 矩阵乘方 \ 左除 

  - 相减 .^ 数组乘方 / 右除 

  * 矩阵相乘   ./ 数组右除 

.* 数组相乘   .\ 数组左除 

>> clear 
>> a=[2 3 4;4 5 6];b=[3 2;1 2; 4 5]; 
>> a*b 
ans = 
    25    30 
    41    48 
>> a.*b 
??? Error using ==> .* 
Matrix dimensions must agree. 
2、关系运算符 

       关系运算符用于比较数、矩阵、字符串之间的大小或不等关系，其返回值为 0

或 1。 

       关系运算符有：<小于、>大于、<=小于等于、>=大于等于、==等于、~=不等于。 

假设有：A=[1 2 -1 -5]、B=[0 2 3 1] 

A>B    ans=[1 0 0 0]                      A>1  ans=[0 1 0 0] 

A<=B   ans=[0 1 1 1]                      A>=B   ans=[1 1 0 0]   

A=B    ans=[0 1 0 0]                      A=1   ans=[1 0 0 0] 

A~=B   ans=[1 0 1 1]                      A~=1 ans=[0 1 1 1] 

3、逻辑运算符 

  在 MATLAB中有 4种基本的；逻辑运算符：&与、|或、~非、xor异或。在处理逻

辑运算时，运算元只有两个值即 0和 1，所以如果指定的数为 0，MATLAB认为其为 0，

而任何数不等于 0，则认为是 1。 

设有：A=[5 -4 0 -0.5]，B=[0 1 0 9] 

A&B=[0 1 0 1]， A|B=[1 1 0 1]，~A=[0 0 1 0]，~1=0 

（六） 矩阵运算 

1、矩阵的要素 
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l 整个矩阵必须用方括号“[]”括起来； 

l 矩阵 A(m,n)表示矩阵变量 A是一个 m行 n列的矩阵。 

l 矩阵行与行之间必须用分号“；”或在输入完一行之后直接用回车键【Enter】

隔离； 

l 矩阵元素之间必须以逗号“，”或空格号分离。 

l 矩阵在 MATLAB中于是按先列后行的方式储存。 

2、矩阵的建立 

（1）直接在命令窗口中输入 

例如： 

>> a=[1 2 3;4,5,6;7 8,9] 

a = 

     1     2     3 

     4     5     6 

     7     8     9 

（2）语句生成 

l 冒号生成法：用线性等间距生成向量矩阵（start：step：end） 

其中 start为起始值，step为步长，end为终止值。当步长为 1时可省略 step

参数。step取正数，起始值 start<终止值 end ；step取负数，起始值 start>终止值

end。 

例如：用线性等间距生成向量矩阵 

>> a=[1:2:10] 

a = 
     1     3     5     7     9 
l 定数线性采样法：a=linspace(n1,n2,n) 
在线性空间上，行矢量的值从 n1到 n2，数据个数为 n，缺省 n为 100。 

例如：用 linspace生成向量矩阵 

>> a=linspace(1,10,10) 

a = 

     1     2     3     4     5     6     7     8     9    10 

l 定数对数采样法 a=logspace(n1,n2,n) 

在对数空间上，行矢量的值从
110n
到

210n
，数据个数为 n，缺省 n为 50。这个指

令为建立对数频域轴坐标提供了方便。 

例如：用 logspace生成向量矩阵 

>> a=logspace(1,3,6) 
a = 
  1.0e+003 * 
    0.0100    0.0251    0.0631    0.1585    0.3981    1.0000 

3、一些常用的特殊矩阵 
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l 单位矩阵：eye(m,n)；eye(m) 
l 零矩阵：zeros(m,n)；zeros(m) 
l 纯 1矩阵：ones(m,n)；ones(m) 
l 对角矩阵：对角元素向量 V=[a1,a2,…,an]，A=diag(V) 
l 随机矩阵：rand(m,n)产生一个m×n的均匀分别的随机矩阵 

4、矩阵基本运算 

矩阵与矩阵之间可以进行加（+）、减（-）、乘（*）、除（/或\）、幂（^）、对数（logm）、

指数(expm)运算，点运算（.^）是两个维数相同矩阵对应元素之间的运算。两矩阵相加

减，要求两矩阵具有相同的行数，相同的列数。只有当两个矩阵中前一个矩阵的列数和

后一个矩阵的行数相同时，才可以进行乘法运算。a\b运算等效于求 a*x=b的解；而 a/b

等效于求 x*b=a的解。只有方阵才可以求幂。 

表 1-3        矩阵基本运算示例 
a=[1 2;3 4]；b=[ 3 5; 5 9] 

》c=a+b，d=a-b 》a*b=[13  23;29  51] 
d= 

-2   -3 
-2   -5 

》c=  
4  7  
8  13 

》a/b=[-0.50  0.50;3.50  –1.50] 》a\b=[-1  -1;2  3] 

》a^3=[37  54; 81  118] 》a.*b=[3  10;15  36] 
》a./b=[0.33  0.40;0.60  0.44] 》a.\b=[3.00  2.50;1.67  2.25] 
》a.^3= [1  8； 27  64]  

（七） 绘图简介 

1、基本的绘图命令 
l plot（x,y,） 
l x,y分别为 x,y轴坐标值，以逐点连折
线的方式绘制 1个二维图形。 

>>x=(0:pi/10:2*pi); y=sin(x); plot(x,y)  
得到图 1-2所示的二维图形。 

2、建立图形窗口                                图 1-2   二维图形 
figure（1）；figure（2）；…；figure(n)打开不同的图形窗口，以便绘制不同的图

形。 
3、grid on：在所画出的图形坐标中加入栅格 

grid off：除去图形坐标中的栅格。 
4、hold on：把当前图形保持在屏幕上不变，同时允许在这个坐标内绘制另外一个图形。 
hold off：使新图覆盖旧的图形。 
5、axis设定轴的范围 

axis（[xmin xmax ymin ymax]）设定 x轴与 y轴的最大、最小坐标。 
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axis(‘equal’)：将 x坐标轴和 y坐标轴的单位刻度大小调整为一样。 
6、文字标示 

l text(x,y,’字符串’) 
在图形的指定坐标位置(x,y)处，标示单引号括起来的字符串。 
l gtext(‘字符串’) 
利用鼠标在图形的任意位置标示字符串。 
l title(‘字符串’) 
在所画图形的最上端显示说明该图形标题的字符串。 
l xlabel(‘字符串’)，ylabel(‘字符串’)  
设置 x，y坐标轴的名称。 
l 输入特殊的文字需要用反斜杠（\）开头 

7、subplot（mnk）：分割图形显示窗口，在同一个窗口中显示多个图形。 
l m：上下分割个数 
l n：左右分割个数 
l k:：子图编号 

8、semilogx：绘制以 x轴为对数坐标（以 10为底），y轴为线性坐标的半对数坐标图
形。 

semilogy：绘制以 y 轴为对数坐标（以 10 为底），x 轴为线性坐标的半对数坐标
图形。 

（八） 程序流程控制 

1、for循环语句 
l 基本格式 

for   循环变量＝起始值：步长：终止值 
循环体； 
end 

l 其中：步长缺省值为 1，可以在正实数或负实数范围内任意指定。对于正数，
循环变量的值大于终止值时，循环结束；对于负数，循环变量的值小于终止值时，

循环结束。循环结构可以嵌套使用。 
2、while循环语句 

l 基本格式 

while   表达式 

循环体； 

End 

l 若表达式为真，则执行循环体的内容，执行后再判断表达式是否为真，若不为
真，则跳出循环体，向下继续执行。While循环和 for循环的区别在于，while循
环结构的循环体被执行的次数不是确定的，而 for结构中循环体的执行次数是确
定的。 
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3、if，else，elseif语句 
l if      逻辑表达式 
执行语句 
end 

l if   逻辑表达式 
执行语句 1 
else 
执行语句 2 
end 

l if   逻辑表达式 1 
执行语句 1 
elseif   逻辑表达式 2 
执行语句 2endif-else的执行方式为：如果逻辑表达式的值为真，则执行语句
1，然后跳过语句 2，向下执行；如果为假，则执行语句 2，然后向下执行。 

l if-elseif的执行方式为：如果逻辑表达式 1的值为真，则执行语句 1；如果为
假，则判断逻辑表达式 2，如果为真，则执行语句 2，否则向下执行。 

4、switch语句 
l 格式：switch   表达式（％可以是标量或字符串） 

case     值 1 
语句 1 
case     值 2 
语句 2 
…. 
otherwise 
语句 3 
end 

l 执行方式：表达式的值和哪种情况(case)的值相同，就执行哪种情况中的语
句，如果不同，则执行 otherwise中的语句。 

l 格式中也可以不包括 otherwise，这时如果表达式的值与列出的各种情况都

不相同，则继续向下执行。 

 

第二部分        SIMULINK仿真基础 

（一）SIMULINK的启动 

1、在MATLAB命令窗口中输入 simulink后回车。 

2、单击MATLAB界面工具栏的 图标。 
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(二) SIMULINK常用模块库介绍 

1、连续模块库（Continuous） 

l Integrator（积分模块）：输入信号的连续时间积分 

该模块将输入信号经过数值积分，在输出端直接反映出来。 

模块功能：对输入变量进行积分。 

说    明：（1）输入的信号既可以是标量，也可以是矢量。 

         （2）输入信号的维数必须与输入信号保持一致。 

l Derivative（微分模块）：数值微分 

该模块将输入端的信号经过一阶数值微分，在输出端输出。 

模块功能：通过计算差分
t
u
D

D
近似计算输入变量的微分。 uD 为输入的变量， tD

为自前一次仿真以来的时间变化量。 

说明：（1）模块的输入可以是标量，也可以是矢量。  

（2）在仿真开始前的输入信号值假设为 0，模块的初始输出为 0。 

（3）微分结果的准确性取决于仿真步长，步长越小，输出结果越精确。 

l Transfer-Fcn（传递函数模块）：分子分母形式的线性传递函数模型 

传递函数常用来描述频域下的线性微分方程，是线性系统的一种时域描述。 

模块功能：用于执行一个线性传递函数。 

说明：（1）传递函数的一般形式 

      （2）分母的多项式就是系统的特征多项式。 

l Zero-Pole（零极点传递函数模块）：以零极点表示的传递函数模型 

该模块用于实现一个特定的零极点系统。 

模块功能：用于建立一个预定的零点、极点，并用延始算子 S表示的连续系统。 

说明：（1）系统的零点、极点或为实数，或为共轭复数形式出现。 

（2）此模块的设置为： Zeros参数设置零点矢量；Poles参数设置极点矢

量；Gain参数设置增益系数。 

2、Math  Operations（数学模块） 

l Sum：求和模块 

用于对多路输入信号进行加减运算，并输出结果。 

l Product：乘法模块 

用于实现对多路输入信号的乘积、商、矩阵乘法或者模块的转置。 

l Gain：增益模块 

用于把输入信号乘以一个指定的增益因子，使输入产生增益。 

l Trigonometric  Function：三角函数模块   

用于给输入信号施加一些常用的三角函数运算，包括正弦、余弦、正切等。 

说明：用户可以从 Function表中有 11种三角函数供选择，分别是：exp、log、
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10u、log10、square、aqrt、pow、reciprocal、hypot、rem、mod。 

l Math Function：常用数学函数模块 

用于给输入信号施加一些常用的数学函数运算。 

说明：用户可以从 Function表中有 10种三角函数供选择，分别是：sin、cos、

tan、asin、acos、atan、atan2、sinh、cosh、tanh。 

3、Signal  Routing（信号线路模块） 

l Mux：将多个单一输入转化为一个复合输出。 

l Demux：将一个复合输入转化为多个单一输出。 

4、Sinks（接收器模块） 

l Scope：示波器。 

用于显示输入信号与仿真时间的关系曲线，仿真时间为 X轴。Scope模块可

以有多个显示坐标（每个端口一个），允许用户调整时间量和输入值的显示范围，

用户也可以移动和调整模块窗口的大小，并且可以在仿真时间内修改 Scope模块

的参数。 

l XY Graph：二维信号显示模块 

用于在 MATLAB 图形窗口上显示一个二维图。模块有两个输入，模块根据输

入的第一个数据（X方向）和第二个数据（Y方向）绘图。 

5、Sources（输入源模块） 

l Constant：输入常数模块 

该模块的输出是个与时间无关的常数，该常数可以是实数，也可以是复数。 

l Pulse  Generator：脉冲信号 

该模块用于产生固定频率的脉冲序列。 

l Ramp：斜波信号 

该模块指定初始时间、初始幅度和变化率的斜波信号。 

l Signal  Generator：信号发生器 

该模块用于产生正弦、方波、锯齿波等三种不同的波形。 

l Sine  Wave：正弦波信号 

该模块产生一个正弦曲线。 

l Step：阶跃信号 

该模块可在指定时间产生一个可定义上下电平的阶跃信号。若仿真时间小

于 Step  time参数值，模块输出为 Initial value参数值。对于大于或等于 Step  

time，输出为 Final value参数值。该模块根据参数的长度产生一个标量或矢量

输出。 

（三）SIMULINK功能模块的处理 

1、拖曳模块:：模块库中的模块可以直接用鼠标进行拖曳（选中模块，按住鼠标左键不
放）而放到模型窗口中进行处理。 

2、移动：选中模块，按住鼠标左键将其拖曳到所需的位置即可。若要脱离线而移动，
可按住 shift键，再进行拖曳。 
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3、复制：选中模块，然后按住鼠标右键进行拖曳即可复制同样的一个功能模块。 
4、删除：选中模块，按 Delete 键即可。若要删除多个模块，可以同时按住 Shift 键，

再用鼠标选中多个模块，按 Delete 键即可。也可以用鼠标选取某区域，再按
Delete键就可以把该区域中的所有模块和线等全部删除。 

5、转向：为了能够顺序连接功能模块的输入和输出端，功能模块有时需要转向。在菜
单 Format中选择 Flip Block旋转 180度，选择 Rotate Block顺时针旋转 90度。
或者直接按 Ctrl+F键执行 Flip Block，按 Ctrl+R键执行 Rotate Block。 

6、改变大小：选中模块，对模块出现的 4个黑色标记进行拖曳即可。 
7、模块命名：先用鼠标在需要更改的名称上单击一下，然后直接更改即可名称在功能

模块上的位置也可以变换 180度，可以用 Format菜单中的 Flip Name来实现，
也可以直接通过鼠标进行拖曳。Hide Name可以隐藏模块名称。 

8、颜色设定： Format菜单中的 Foreground Color可以改变模块的前景颜色，Background 
Color可以改变模块的背景颜色；而模型窗口的颜色可以通过 Screen Color来
改变。 

9、参数设定：用鼠标双击模块，就可以进入模块的参数设定窗口，从而对模块进行参
数设定。参数设定窗口包含了该模块的基本功能帮助，为获得更详尽的帮助，

可以点击其上的 help按钮。通过对模块的参数设定，就可以获得需要的功能
模块。 

（五）SIMULINK信号线的处理 

SIMULINK模型的构建是通过用信号线将各种功能模块进行连接而构成的。用
鼠标可以在功能模块的输入与输出端之间直接连线。所画的线可以改变粗细、设定标签，

也可以把线折弯、分支。 

1、改变粗细：信号线所以有粗细是因为线引出的信号可以是标量信号或矢量信号，当

选中 Format菜单下的 Wide Vector Lines时，信号线的粗细会根据信号线所

引出的信号是标量还是矢量而改变，如果信号为标量则为细线，若为向量则为

粗线。选中 Vector Line Widths则可以显示出向量引出线的宽度，即向量信

号由多少个单一信号合成。 

2、设定标签：只要在信号线上双击鼠标，即可输入该信号线的说明标签。也可以通过

选中信号线，然后打开 Edit 菜单下的 Signal Properties 进行设定，其中

signal name属性的作用是标明信号的名称，设置这个名称反映在模型上的直

接效果就是与该信号有关的端口相连的所有直线附近都会出现写有信号名称

的标签。 

3、信号线的折弯：按住 Shift键，再用鼠标在要折弯的信号线处单击一下，就会出现

圆圈，表示折点，利用折点就可以改变信号线的形状。 

4、信号线的分支：按住鼠标右键，在需要分支的地方拉出即可。或者按住 Ctrl键，并

在要建立分支的地方用鼠标拉出即可。 

5、模块与信号线的分离：将鼠标放在想要分离的模块上，按住 Shift键，再用鼠标把

模块拖曳到别处，即可将模块与信号线分离。 
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6、信号线的分割：先选中信号线，按住 Shift键，然后在信号线上需要分割的点上单

击鼠标左键。此时，信号线就在此点上被分割为两段，拖曳新节到适当位置，

然后松开左键，则新节点就会移动到新的位置上。 

7、移动节点：选中要移动的节点，则鼠标指针形状变为圆形。拖曳节点到新的位置，

放开鼠标，则新节点就被移动到新的位置。 
8、信号线的删除：选中信号线后按 Delete即可。 
9、信号线的移动：选中要移动的信号线，拖动鼠标到指定位置即可。 

（六）SIMULINK仿真的运行      

运行一个仿真的完整过程分成三个步骤：设置仿真参数，启动仿真和仿真结果分析。 
1、设置仿真参数和选择解法器 

设置仿真参数和选择解法器，选择

Simulation菜单下的 Simulation Parameters命
令，就会弹出一个仿真参数对话框，如图 1-3
所示，它主要用五个页面来设置仿真的参数： 

（1）Solver页：此页可以进行的设置有：
选择仿真开始和结束的时间；选择解法器，并

设定它的参数；选择输出项。 

①仿真时间（ Simulation time） 
缺省时的起始时刻为 0.0s,终止时刻为         图 1-3   设置仿真参数                                            

10.0s。只要在 Start time和 Stop time文本框内输入新的数值，即可修改仿真时间。 

②仿真步长模式(Solver options) 
用户可在 Type后面的第一个下拉选项框中指定仿真的步长选取方式。可供选择的

有 Variable-step（变步长）和 Fixed-step（固定步长）方式。 
变步长模式解法器有：ode45，ode23，ode113，ode15s，ode23s，ode23t，ode23tb

和 discrete。ode45是缺省值。 

固定步长模式解法器有：ode5，ode4，ode3，ode2，ode1和 discrete。 

ode5是缺省值。 
③步长参数 

l 对于变步长模式，用户可以设置最大的和推荐的初始步长参数，缺省情况下，
步长自动地确定，它由值 auto表示。 

a)Maximum step size（最大步长参数）： 
它决定了解法器能够使用的最大时间步长，它的缺省值为“仿真时间/50”，即整个

仿真过程中至少取 50个取样点。 
b)Initial step size（初始步长参

数）：一般建议使用“auto”默认值即可。 
c) Minimum step size（最小步长

参数）：一般建议使用“auto”默认值即
可。 
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l 对于定步长模式，可以设置固定步长的大小与任务模式。 
Fixed step size（固定步长参数）：一般建议使用“auto”默认值即可。 

④仿真精度的定义（对于变步长模式）         图 1-4   解法器选择 
a) Relative tolerance（相对误差）： 
缺省值为 1e-3，表示状态的计算值要精确到 0.1%。 
b)Absolute tolerance（绝对误差）：表示误差值的门限，或者是说在状态值为零的情

况下，可以接受的误差。如果它被设成了 auto，那么 simulink为每一个状态设置初始绝
对误差为 1e-6。 
2、启动仿真 

①选择 Simulation菜单下的 start选项来启动仿真，如果模型中有些参数没有定义，
则会出现错误信息提示框。 

②单击模型窗口工具栏的 图标。 

 

第三部分  典型控制系统建模分析 

（一）仿真模型的建立步骤 
l 建立系统的数学模型 
l 新建模型窗口 
l 根据数学模型寻找到所需的功能模块，并将功能模块由模块库窗口复制到模型窗口 
l 对模块进行连接，从而构成需要的系统模型 
l 设置仿真参数 
l 运行仿真模型 

l 分析仿真结果，然后根据分析，进一步修正系统的数学模型和仿真模型。 

（二）控制系统建数学模型 
1、连续系统的传递函数模型 

在MATLAB中，系统的传递函数模型可以由分子和分母系数构成的两个向量唯
一地确定出来，这两个向量分别用 num和 den表示。用函数 tf（num，den）就可得
到系统的传递函数。 

l 分子    num=[b1,b2,…,bm,bm+1] 
l 分母    den=[a1,a2,…,an,an+1] 
l 注意：它们都是按 s的降幂进行排列的。 

2、零极点增益模型 

分别对系统传递函数的分子、分母进行因式分解处理，以获得系统的零点和极点

的表示形式。 
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l K 为系统增益，zi 为零点，pj 为极点，在 MATLAB中零极点增益模型用[z,p,K]矢

量组表示。 

l z=[z1,z2,…,zm]，p=[p1,p2,...,pn] ，K=[k] 

l 函数 tf2zp()可以用来求传递函数的零极点和增益。 

3、模型的转换 

模型转换的函数包括： 

l tf2zp：传递函数模型转换为零极点增益模型 

l zp2tf：零极点增益模型转换为传递函数模型 

4、模型的建立 

l parallel系统的并联连接 

格式： 

[num,den]=parallel(num1,den1,num2,den2) 

说明： 

[num,den]=parallel(num1,den1,num2,den2)可得到并联连接的传递函数表示的

系统，其结果为 

2*1
2*21*1

denden
dennumdennum

den
num +
=  

l series系统的串联连接 

格式： 

 [num,den]=series(num1,den1,num2,den2) 

说明： 

Series函数将两个系统按串联方式连接，既可以适用于连续时间系统，也适合于

离散时间系统。 
l feedback两个系统的反馈连接 

格式： 

[num,den]=feedback(num1,den1,num2,den2) 

[num,den]=feedback(num1,den1,num2,den2,sign) 

说明： 

Feedback 函数可将两系统按照反馈方式连接，如

图 1-5所示。                                             图 1-5   反馈连接 

一般而言，系统 1为对象，系统 2为反馈控制器。Feedback函数既可以适用于连

续时间系统，也适合于离散时间系统，sign 指定两系统要连接的符号，默认为负，即

sign=-1。 
l cloop系统的闭环形式 

格式： 

[numc,denc]=cloop(num,den,sign) 
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说明：                                                  图 1-6   闭环连接 

Cloop 函数将系统输出反馈到系统输入形成闭环系统。开环系统的输入输出仍然

是闭环系统的输入输出。Cloop函数既适用与连续系统，也适用于离散系统。 

当 sign=1时采用正反馈；当 sign=-1时采用负反馈；当 sign缺省时，默认为负

反馈。 

l ord2产生二阶系统 

格式： 
[a,b,c,d]=ord2(Wn,z) 

[num,den]=ord2(Wn,z) 

说明：z表示ξ ，Wn表示 nω 。 

6、举例 

（1）传递函数 

》num=[12,24,0,20];den=[2 4 6 2 2]; tf(num,den) 

Transfer function: 

     12 s^3 + 24 s^2 + 20 

------------------------------- 

2 s^4 + 4 s^3 + 6 s^2 + 2 s + 2 

（2）零极点增益模型 

》num=[1,11,30,0]; 

》den=[1,9,45,87,50]; [z,p,k]=tf2zp(num,den) 

z= 

    0 

   -6 

   -5 

p= 

   -3.0000+4.0000i 

   -3.0000-4.0000i 

    -2.0000 

    -1.0000 

k= 

    1 

结果表达式： 

（3）系统的零极点增益模型： 

》z=[-3];p=[-1,-2,-5];k=6; 

》[num,den]=zp2tf(z,p,k) 

》num= 0  0  6  18    

 den= 1  8  17  10 

(4)系统的并联与串联连接 

两系统
4

3)(1
+

=
S

Sg 与
32

42)(2 2 ++

+
=

SS
SSg  

>> num1=[3] 

)43)(43)(2)(1(
)5)(6()(

jsjsss
ssssG

-+++++
++

=
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num1 = 

     3 

>> den1=[1 4] 

den1 = 

     1     4 

>> num2=[2 4] 

num2 = 

     2     4 

>> den2=[1 2 3] 

den2 = 

     1     2     3 

>> [nums,dens]=series(num1,den1,num2,den2) 

nums = 

     0     0     6    12 

dens = 

     1     6    11    12 

>> [nump,denp]=parallel(num1,den1,num2,den2) 

nump = 

     0     5    18    25 

denp = 

     1     6    11    12 

(5)系统的反馈连接 

32
152)( 2

2

++

++
=

SS
SSSg 与

10
)2(5)(

+

+
=

S
SSh  

>> numg=[2 5 1],deng=[1 2 3] 

numg = 

     2     5     1 

deng = 

     1     2     3 

>> numh=[5 10],denh=[1 10] 

numh = 

     5    10 

denh = 

     1    10 

>> [num,den]=feedback(numg,deng,numh,denh) 

num = 

     2    25    51    10 

den = 

11    57    78    40 
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(6)要产生ξ =0.4， nω =2.4rad/s的二阶系统 

>> [num,den]=ord2(2.4, 0.4) 

num = 

     1 

den = 

    1.0000    1.9200    5.7600 

（三）典型控制系统建模分析 

根据动力学方程 Fkxxcxm =++
···

，学习创建简单的 SIMULINK 模型。其

中，阻尼系数 c =1.0，弹簧弹性系数 k =2，质量m =5， 0)0(,0)0( ==
·

xx ，外

力为幅值等于 1的阶跃量。 

 

具体步骤： 
1、启动 MATLAB。 

 

2、在命令窗口输入 simulink

后回车，进入 Simulink Library 

Browser模块库浏览器，如图1-7所示。 
 

3 、 在 Simulink Library 

Browser 窗口下，选择 File→New→

Model，打开一个新的模型窗口。    图 1-7  模块库浏览器 Library Browser 

如下图 1-8所示 

4、添加模块 

①这是个二阶系统，需要求解微分方程的积分模

块。积分模块的输入为
··

x与
·

x，输出分别为
·

x  

与 x ,从连续模块库（Continuous）拖曳两个积分      

模块(Integrator)到模型窗口。 

图 1-8  模型窗口           ②从数学操作模块库（Math Operations）中拖曳

三个增益模块(Gain)到模型窗口,再拖曳一个求和模块（Sum）到模型窗口。 

③从输入源模块（Sources）中拖曳一个阶跃模块（Step）到模型窗口。 

④从接受模块(Sinks)中拖曳一个示波器模块（Scope）到模型窗口。 

将各个模块按顺序排好，最后得到如下图形图 1-9。 
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图 1-9  添加模块 

⑤选中增益模块 Gain1 和 Gain2，选择模型窗口菜单命令 Format→Flip→Block,

则两增益模块 Gain1 和 Gain2 的输入输出端口互换了位置。并双击求和模块

(Sum) ，弹出 Block Parametersd 对话框，修改 Icon Shaper 为 Rectangular，

并将 List of Signs改为（+  -  -），单击 OK确定。得到图 1-10。 

图 1-10  修改后的模块图 

5、连接模块 

①连接信号线：在输入模块 Step的输出口处按下右键，则指针变成十字叉形。按

住鼠标并拖曳到增益模块 Gain的输入口处，则十字叉变成双十字叉。放开鼠标按键，

即可形成新的信号线。其他同理。 

②添加标注：在增益模块下方双击 Gain，改为 1/m；在求和模块 Sum 下方双击，

添加注释 Sum；双击积分模块的 Integrator 和 Integrator1，分别将 Integrator、

Integrator1改为 shudu（速度）、weiyi（位移）；双击增益模块下方的 Gain1和 Gain2，

改为 c/m,k/m。 

添加标注的作用是使模型更加

清晰易懂，最后得到图 1-11。 

 

6、设置仿真参数 

①双击增益模块 1/m，c/m，k/m，

修改增益为 0.2，0.2，0.4，如图 1-12。                   图 1-11  模型图 
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图 1-12  设置参数后的模型图 

② 选 择 菜 单 Simulation → Simulation 

Parameters,弹出 Simulation Parameters 对话

框，设置仿真停止时间 Stop time 为 100，如图

1-13所示。                                      图 1-13 设置仿真时间 

                                                   
7、运行仿真 

l 双击示波器模块 Scope，并
选择 Simulation→Start 命令
运行模型。示波器窗口绘制

出仿真后的图形，如图 1-14

所示。 

 

 

 

 

 

                                图 1-14 示波器窗口 

l 单击示波器窗口工具栏的自动调节

尺寸控件 ，则示波器窗口会自动把

坐标调节到合适的取值范围，以便观察，

如图 1-15所示。                
 
                                

 

8、传递函数模型： 

也可以将动力学方程 Fkxxcxm =++
···

变换为传递函数

m
kS

m
cS

mSG
++

=
2

/1)(
。从             图 1-15 经调整的示波器窗口 
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输入源模块（Sources）中选择一个阶跃模块（Step），从连续模块库（Continuous）选

择一个传递函数模块（Transfer Fcn），从接受模块(Sinks)中选择一个示波器模块

（Scope），参照前面建立到模型。将仿真停止时间设为 100，并将传递函数 Transfer Fcn

对话框中分子 Numerator设为[0.2]，分母 Denominator设为[1，0.2，0.4]，如图 1-16

所示，所得结果与前面相同。         

 

图 1-16  传递函数模型窗口 

五、 实验报告要求 

1、书写实验目的、实验所用设备。 

2、习题的具体解题过程（包括所用的命令、所用的步骤）。 

3、实验体会：对 MATLAB/Simulink的强大功能的了解,体会 MATLAB给我们带来的

方便与快捷。 

六、 练习题 

1、计算 y=sin(π /36.56),
214.31 yyy += 。 

2、用线性等间距生成向量矩阵：要求以π /10开始，到π 结束，步距为π /32。 

3、用定数线性采样法：a=linspace(n1,n2,n)生成一以π /10开始，到π 结束，有 500

个数的矩阵。 
4、生成一 5行 5列的随机矩阵 a，并求其对角矩阵 b，对所得的两个矩阵 a与 b 进行
以下运算：加（+）、减（-）、乘（*）、除（/或\）、点运算（.^）。 
5、求上述矩阵 a的行列式的值，用 eig求矩阵 a的特征值和特征向量。 

6 、 用 conv 、 dconv 指 令 求 两 多 项 式 a*b 、 a/b 的 值 ：

3258.0643.9037.5625.3 23 --+= xxxa ， xxexxb π+--= 25324 98123  

7、绘制函数 )6cos()sin( xxxy += 在[0，3]之间的曲线。要求加上标题、两坐标符号。 

8、编程计算 1到 20的总和。 

9、用 Simulink分析传递函数
)4)(25(

12)(
++

=
SSS

SG 在单位阶跃信号下的响应。 
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实验二   一、二系统时域特性分析 

二、 实验目的 

1、掌握一阶系统的时域特性，理解时间常数 T对系统性能的影响。 

2、掌握二阶系统的时域特性，理解二阶系统的两个重要参数ξ 和 nω 对系统动态

特性的影响，并用固高球杆系统进行验证。 

3、理解二阶系统的性能指标，掌握它们与系统特征参数ξ 、 nω 之间的关系。 

4、了解使用 MATLAB/SIMULINKMATLAB进行时域特性分析的方法。 

三、 实验设备 
序号 仪器设备名称 数量 

1 计算机 1 

  2         MATLAB软件               1 

  3        固高球杆系统              1 

  4        打印机              1 

四、 实验要求 
1、了解典型输入信号，理解时间响应的概念，理解掌握时间响应分析和性能指标的计

算。 

2、对于一阶惯性环节
1

1)(
+

=
TS

SG ： 

(1)重点掌握当输入信号为单位阶跃信号时，对应的响应曲线特点；掌握当系统

参数 T改变时，对应的响应曲线变化特点，以及对系统的性能的影响。 

（2）了解当输入信号分别改为单位脉冲信号、单位速度信号时，响应曲线的变

化情况及特点。 

（3）通过对实验结果的观察、分析和比较，总结对于同一个系统，当输入信号

不同时，对系统的性能的影响。 

3、对于二阶系统：
22

2

2
)(

nn

n

SS
SG

ωζω
ω
++

=  

（1）了解输入信号为单位阶跃信号时，对应的响应曲线的特点及系统参数ξ、ωn

改变时（分别取ξ＝0、ξ＝1、ξ>1、0<ξ<1），对应的响应曲线的变化特点及对系统

性能的影响。 
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（2）重点掌握欠阻尼二阶系统的单位阶跃响应曲线，当系统参数ξ、ωn改变时，

系统的性能指标的变化情况；掌握系统性能指标有哪些，各表示系统哪些方面的特性。 

（3）了解当输入信号改为单位脉冲、单位速度信号时，响应曲线的变化情况。 

（4）通过对实验结果的观察、分析和比较，总结对于同一个系统，当输入信号不

同时，对系统的性能的影响。  

4、将实验结果与理论分析的结果进行比较，验证理论的正确性。 

5、将实验数据、图形曲线、性能指标打印出来。 

五、 实验原理 
1、一阶系统的时域分析 

一阶系统的闭环传递函数
1

1
)(
)()(

+
==F

TSSR
SCS ，系统的输入信号为 )(tr ，则零初

始条件下一阶系统的时域输出 )(tc 为 )](
1

1[)( 1 SR
TS

Ltc
+

= -  

（1）当 )(tr =1时，系统的响应过程 )(tc 称为单位阶跃响应 T
t

etc
-

-=1)(  

 （2） 当 )()( ttr δ= ，一阶系统的脉冲响应是一单调下降的指数曲线， T
t

e
T

tc
-

=
1)(

（3）当 )(tr =t,一阶系统在跟踪单位斜坡输入时有跟踪误差,且 Tet ®¥¥® )(,   

)1()( T
t

eTttc
-

--=  

2、二阶系统的时域分析 

二阶系统的闭环传递函数 22

2

2)(
)(

nn

n

SSSR
SC

ωξω
ω

++
=  

ξ ——阻尼比  nω ——无阻尼自振频率 

（1）二阶系统的单位阶跃响应  

    当系统的输入信号为 )(1)( ttr = ，则零初始条件下二阶系统的拉氏变换式为 

SSS
SC

nn

n 1.
2

)( 22

2

ωξω
ω

++
=                  

（2）性能指标  

l 延迟时间 dt ：输出响应第一次达到稳态值的 50%所需的时间。 
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0
tr tp ts

t

y
m axy

)(¥y

2
)(¥y

(05.0 ¥y

(0 2.0 y
或

td

l 上升时间 rt ：输出响应第一次达到稳态值 y(∞)所需的时间， 
d

rt ω
θπ -

=  

l 峰值时间 pt : 输出响应超过稳态值达到第一个峰值 ymax所需要的时间
d

pt
ω
π

=  

l 最大超调量（简称超调量） pM 或 %δ ： %100
)(

)()( 21 ´=
¥

¥-
= -

-
ξ

ξπ

e
y

yty
M p

p  

l 调节时间或过渡过程时间 st ： 

当 y(t)和 y(¥)之间的误差达到规定的范围之内[比如 0.02或 0.05 ]，且以后不

再超出此范围的最小时间。即当 stt ³ ，有 2),(%)()( =D¥´D£¥- yyty 或 3。 

l 振荡次数 N： 

在调整时间内，响应过程 )(ty 穿越其稳态值 )(¥y 次数的一半定义为振荡次数

d

s

T
tN = ，   其中

d
dT

ω
π2

= 为阻尼振荡周期。 

在上述几种性能指标中， pt 、 rt 、 st 表

示瞬态过程进行的快慢，是快速性指标；而

pM 、N反映瞬态过程的振荡程度，是振荡性指标。 

3、利用 MATLAB求取系统的时域响应                  图 2-1    时域响应图 
（1）求取系统单位阶跃响应：step(num,den) 

step(num,den,t)：其中 num和 den分别为系统传递函数描述中的分子和分母多项

式系数，t为选定的仿真时间向量，一般可以由 t=0:step:end等步长地产生出来。该

函数返回值 y为系统在仿真时刻各个输出所组成的矩阵。 

（2）求取系统的脉冲响应：impulse() 

求取脉冲激励响应的调用方法与 step()函数基本一致 impulse(num,den,t)  

4、例子 

例 1：已知系统的开环传递函数为
SSSS

SG
40368

20)( 234 +++
= ，求系统在单位

负反馈下的单位阶跃响应。 

clc %清除命令窗口 

clear %从内存中清除变量和函数  
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close all %关闭所有图形 

%开环传递函数描述 

num=[20]; 

den=[1 8 36 40 0]; 

%求闭环传递函数 

[numc,denc]=cloop(num,den); 

%绘制闭环系统的阶跃响应曲线 

t=0:0.1:10; 

y=step(numc,denc,t); 

[y1,x,t1]=step(numc,denc); 

例 2：已知系统的传递函数为
1

1
)( 2 ++

+
=

SKS
SKSG

d

d (令 Kd=5)，求系统的单位脉冲

响应。 

clc %清除命令窗口 

clear%从内存中清除变量和函数 

close  %关闭打开的图形 

%系统传递函数描述 

num=[5 1]; 

deno=[1 5 1]; 

%绘制系统的脉冲激励响应曲线 

t=1:0.1:10; 

[y,x]=impulse(numc,denc,t); 

plot(t,y) 

title('the impulse responce') 

xlabel('time-sec') 

六、 实验内容与步骤 
1、一阶系统的阶跃响应 

（1） 在 MATLAB命令窗口中输入 M

文件名 shiyan2后回车,得到如图 2-2所示。         图 2-2    实验二界面                                                                                             

（ 2 ） 在 右 图 所 示 界 面 中 单 击

,弹出如图 2-3所示界面。               

（3）对于单位反馈系统的开环传递函数

1
)(

+
=

TS
KSGK
，分析在 K=20、T=0.2 时的单位

阶跃响应：                                   图 2-3    一阶系统的阶跃响应 

PDF 文件使用 "pdfFactory Pro" 试用版本创建           www.fineprint.cn

http://www.fineprint.cn


 25

①列出系统的闭环传递函数：

1
1

1
1

)(
+

+

+=
++

=
S

K
T

K
K

KTS
KSG

。 

②
21
20

201
20

1
1 =

+
=

+
=

K
KK ，

21
2.0

201
2.0

1
1 =

+
=

+
=

K
TT ，在比例增益 K下的输入框

中输入比例增益 20/21，在时间常数 T下的文本框

中 输入时间常数 0.2/21，然后单击 ,

即可得到一阶系统的脉冲响应曲线，如图 2-4 所

示。 

③单击 可出现网格，单击 可取

消网格。 

④单击 ，弹出 Page Setup 选项框，

即可进行打印页面设置，如图 2-5所示。            图 2-4    一阶系统的阶跃响应 

 

⑤完成打印设置后，选择

即可打印图形。 

⑥单击 即可清除掉所有

的响应曲线。 

（4）参照前面步骤，分析系统

1
1

1
1

)(
+

+

+=
++

=
S

K
T

K
K

KTS
KSG

在 K、T 分别

为（15，0.1）、（2.5，1）下的响应。 

图 2-5    一阶系统的阶跃响应 

 

2、一阶系统的脉冲响应： 

参考前面，分析开环传递函数为
1

)(
+

=
TS

KSGK 的单位反馈系统在 K、T分别为（20，

0.2）、（15，0.1）、（2.5，1）时的单位脉冲响应： 

3、一阶系统的斜坡响应 

参考前面，分析开环传递函数为
1

)(
+

=
TS

KSGK
的单位反馈系统在 K、T分别为（20，

0.2）、（15，0.1）、（2.5，1）时的单位斜坡响应： 
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4、二阶系统的阶跃响应 

（1）在“实验二  系统的时域响应” 界面中，单击 ,

弹出阶跃响应界面，如图 2-6所示。 

 

（2）分析图 2-7所示系统，求系统的

阶跃响应和超调量 pM 、峰值时间 Pt 和调

节时间 St 等性能指标。 

 
图 2-7    系统方框图                 图 2-6    一阶系统的阶跃响应 

① 列 出 系 统 的 闭 环 传 递 函 数

9
9)( 2 ++

=
SS

SG ，得到阻尼比 6/1=ξ ，无阻尼

固有频率 3=nω 。  

②输入阻尼比 1/6 和无阻尼固有频率 3

后，单击 ,即可得到二阶系统的阶跃

响应曲线，如图 2-8所示。 

③单击 ，得到系统的超

调量 pM 等性能指标, 如图 2-9所示。。          图 2-8    系统方框图                

④进行打印设置后，打印响应曲线。 

 

（3）分析系统
P

P

KS
KSG
+

= 2)( 的单位脉冲响应。 

①在固有频率输入框中输入 3，在阻尼比输入框中输入0（因

为 Sn ***2 ωξ 项为 0，即系统的在零阻尼下的响应），

单击 ,即可得到二阶系统的脉冲响应曲线。 

图 2-9    性能指标 

②任意改变 PK 值（即改变系统的无阻尼固有频率），观察系统的脉冲响应，可以
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知道该系统处于临界稳定状态。 

③进行打印页面设置后，打印响应曲线。 

5、二阶系统的脉冲响应 

（1）参考前面步骤，分析图 2-7所示系统，求系统脉冲响应。                                            

（2）参考前面，分析传递函数为
P

P

KS
KSG
+

= 2)( 的系统的单位脉冲响应。 

6、二阶系统的斜坡响应 

（1）参考前面步骤，求图 2-7所示系统的斜坡响应。 

（2）参考前面，分析传递函数为
P

P

KS
KSG
+

= 2)( 的系统的单位斜坡响应。 

7、利用 IPM Motion Studio软件分析球杆系统
P

P

KS
KSG
+

= 2)( 。 

①打开球杆系统的开关电源。 

②选择“开始”→“所有程序” →“IPM Motion Studio 2.1” →，

“IPM Motion Studio”或者双击桌面上 IPM Motion Studio 快捷方式

图标,进入 Technosoft IPM Motion Studio界面,如图 2-10所示。 

③选择“Project” →“Open” →

“ BallBeamEng.msa” →打开。 

选择“Open”后得图 2-11所示的窗口
“ Open Project ” 。 选 择 

“BallBeamEng.msa”，再选择“打开”。 

图 2-10    IPM Motion Studio界面      图 2-11  Open Project窗口   

 

 

最后得到图 1-12所示的窗
口。 

 

 

 

 

                   图 2-12 Technosoft IPM Motion Studio界面 
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④选择“View” →“Project”，弹出一

个标题为“Project”的新窗口，如图 2-13所

示。 

 

⑤单击工具栏上的 ，运行程序。 

⑥单击工具栏上的 ，选择 Ball and 

Beam System，弹出一个参数调节窗口“Ball 

and System”，如图 2-14所示。 

                                图 2-13   Project窗口 

 

在该窗口上右击，弹出一个快捷菜单，

选择“Start”,开始仿真，如图 2-15所示。 

图 2-15   Start窗口                       图 2-14  参数调节窗口窗口 

开始运行后的窗口如图 2-16所示。 

图 2-16   Start窗口 

⑦V型槽的总长度为 400毫米，以槽的右端点为

零点位置。在图 2-16 中，右上角的 Ball 

Reference Position 代表小球在 V 型槽上的理

想位置，如图 2-17所示。           

图 2-17   球的位置                                 
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Ball Actually Position代表小球在 V型槽上的实际

位置。输入位置参数后回车参数更改才有效。 

KP、KI、KD 是 PID 控制参数，既可以直接输入参数

也可以拖动鼠标设置参数。要注意，如果直接输入参数，

必须回车参数更改才有效，如图 2-18所示。 

图2-18   PID控制参数 

在图 2-16中，Ball Actually Position(Red) – Ball Reference Position(White)

表示的是球的位置曲线：红

色的代表球的实际位置曲

线，白色的代表的是球的理

想位置曲线。红色的代表球

的位置误差，黄色的代表球

的速度，如图 2-19所示。                    图 2-19   球的位置曲线 

⑧在 Ball Reference Position 中输入小球的位置 200

（毫米），令 KI、KD都为 0，改变 KP值为 3，观察系统的响应。 

七、 实验报告要求 

1、包括实验目的、实验设备、实验原理。 

2、打印出相应的响应曲线。 

3、描述一阶惯性环节中时间常数 T对环节的影响。 

4、叙述振荡环节中阻尼系数、无阻尼固有频率对环节的影响。 

5、结合实验遇到的问题谈谈对实验的看法。 

八、 思考题 
1、惯性环节的时间常数 T反映了该环节的什么动态特性？ 

2、惯性环节的瞬态响应过程在几倍时间常数 T后结束？ 

3、影响二阶系统动态性能的两个主要参数是什么？反映了系统的什么性能？二

阶系统在什么条件下，其瞬态响应处于要振不振的临界状态？ 

4、根据实验结果，分析二阶系统调节时间 st 、最大超调量 %σ 与 nω 、ξ 之间的

关系？ 

6、对于二阶系统，若将其反馈极性改为正反馈，或者将其反馈回路断开，这时

的阶跃响应有何特点？试从理论上分析？（也可在实验中进行观察） 
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7、对于同一系统，为什么在不同的输入信号作用下，响应曲线有如此大的差异？ 

8、单位反馈系统的开环增益值的变化对系统的性能有什么影响？ 

9、系统的平稳性、快速性和准确性的性能指标是什么？它们之间的要求有什么

矛盾？ 

九、 利用MATLAB进行控制系统时域特性分析（选做、自学） 
1、分析一阶系统的时域特性：在不同时间常数 T与比例增益 K下，比较分析惯性环节

1
)(

+
=

TS
KSG 的单位脉冲响应、单位阶跃响应、单位速度响应。观察惯性环节

1
)(

+
=

TS
KSG 的时域响应曲线，理解时间常数 T与比例增益 K对惯性环节的影响。 

（1）选择模块 

①进入 SIMULINK模块库浏览器：在 MATLAB的命令窗口中输入 simulink后回车

或者单击工具栏上的 图标，启动 SIMULINK 模块库浏览器窗口 Simulink Library 

Browser。 

②新建空白模型：单击 SIMULINK模块库浏览器窗口工具栏上的 或者选择 File

→New→Model，新建一个空白模型窗口，如图 2-20 所示。得到的模型窗口标题为

untitled。 

 
图 2-20   模型窗口 
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③选择输入模块：在库浏览器左侧，双击 Source图标→打开 Source库，把 Pulse 

Generator(脉冲信号发生器模块)拖曳到模型窗口。 

④拖曳传递函数模块：打开 Continuous 库，拖曳一个 Transfer Fun(传递函数

模块)到模型窗口，并放到 Pulse Generator模块之后。如图 2-21所示。 

 
图 2-21       Transfer Fun传递函数模块 

⑤选择输出模块：打开 Sinks 库，拖曳一个 Scope（示波器模块）到模型窗口，

并放在 Transfer Fun模块之后。所有模块都选择好之后，最后得到图 2-22。 

 

（2）添加信号线：把鼠标指

针放到 Pulse Generator(脉

冲信号发生器)的右端箭头

（即输出口处），鼠标指针即

变成十字叉形。按住鼠标右键

并将鼠标从 Pulse Generator

模块的输出口 拖曳到                    图 2-22  添加好的模块 

Transfer Fun模块的输入口

处（Transfer Fun模块左边

的 ），松开鼠标按键，就

把 Pulse Generator 与

Transfer Fun连接起来。最

后得到图 2-23。 

 

 

               图 2-23  添加信号线 
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（3）设置模块参数：双击中间的 Transfer Fun模块，弹出 Block Parameters对话框，

将时间参数 T设为 0.2，将比例增益 K设为 20,即修改传递函数的 Denominator(分母)

为[0.2  1],分子 Numerater为[20]，单击 OK。其余参数采取默认值。如图 2-24所示。 

图 2-24   设置参数 

（4）运行仿真 

①开始仿真：单击工具栏的 图标或选择菜单 Simulation→Start，开始仿真。 

②响应曲线：双击模型窗口中的示波器模块 Scope，弹出的示波器窗口绘制出响

应曲线。 

③调节曲线：单击示波器窗口的自动调节尺寸控件 ，则示波器窗口自动把

坐标调节到合适的取值范围，以便观察。 

（5）打印图形：单击示波器窗口的打印机图标 ，即可打印图形。 

（6）修改参数，观察时间常数 T对响应的影响：分别将 K、T改为（20，0.5），（10，

0.9），修改后单击 OK，运行仿真。 

（７）进行单位阶跃响应： 

①删除 Pulse Generator模块及与传递函数模块 Transfer Fun之间的信号线。 

②用阶跃函数模块 Step代替 Pulse Generator模块作为输入模块并连接好信号线。 

③依次修改 K、T改为（20，0.5）、（16，0.1）、（2.5， 1），运行仿真模型，并打

印响应曲线。 

（８）进行单位速度响应： 

参照前面，用 Ramp(斜坡模块)代替阶跃函数模块 Step作为输入模块，并依次修改

参数，运行仿真模型。 

 

２、分析二阶系统的时域特性：根据下列控制系统方框图 2-24，求出系统的闭环传递

函数，并求阻尼比ξ、无阻尼固有频率ωn时，对比分析上述三种时域响应的响应曲线。 
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图 2-24   系统方框图 

（１）求出系统的闭环传递函数：
9

9)( 2 ++
=

SS
SG 。 

（２）参照前面步骤，建立如图 2-25所示的模型： 

  （３）设置模块参数：双击中

间 Transfer Fun模块，弹出 Block 

Parameters对话框，修改传递函

数分母 Denominator为[1 1 9],

分子 Numeraters为 9，单击 OK。 

图 2-25   系统传递函数 

（４）运行仿真：单击模型窗口上方的 运行仿真，再双击右边那个模块是 Scope

（示波器模块），得到响应曲线。 

（５）修改参数：再令ξ=0.3、ωn  =10，相应修改传递函数 Transfer Fun 中的

Denominator和 Numeraters，运行仿真模型。 

（６）其他响应：分别用 Pulse Generator模块、斜坡模块 Ramp作为输入模块，

并依次修改参数ξ、ωn，运行仿真模型。 

（二）编程分析 

1、求一阶系统的单位脉冲响应： 

num=1;den=[2 1];impulse(num,den) 

2、求一阶系统的单位阶跃响应： 

num=1;den=[2 1];step(num,den) 

3、求二阶系统的单位脉冲响应： 

num=[25];den=[1 6 25];impulse(num,den) 

4、求二阶系统的单位阶跃响应： 

num=[25];den=[1 6 25];step(num,den) 

5 、 求 取 二 阶 系 统 的 性 能 指 标 ： 已 知 控 制 系 统 的 传 递 函 数 为

22

2

2
)(

nn

n

SS
SG

ωζω

ω

++
= ，其中阻尼比ζ =1/6，频率 nω =3rad/s。求该系统在单

位阶跃输入下的上升时间 rt 、调节时间 st 、峰值时间 pt 、最大超调量 %σ 。 

G=tf([3^2],[1  2*(1/6)*3  3^2]);%得到传递函数 

Ka=9 )1(
1
+SS  
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t=[0:0.01:10]';%输入时间 
ys=step(G,t);%计算函数在时间 t时的阶跃响应 
[Mo,tr,ts,tp]=tstats(t,ys);%调用 M文件 tstats.m计算 
disp('最大超调量') 
Mo    %最大超调量 
disp('上升时间') 
tr    %上升时间 
disp('过渡时间') 
ts    %过渡时间 
disp('峰值时间') 
tp   %峰值时间 

M文件 tstats.m 
function [Mo,tr,ts,tp]=tstats(t,ys) 
dimt=length(t);%求取时间 t的长度 
[mp,ind]=max(ys); %求取 ys的最大值以及所在的时刻 
yss=ys(dimt); %求取 ys最终值 
Mo=100*(mp-yss)/yss; %超调量 
tp=t(ind); %峰值时间 
%过渡过程时间 
for i=1:dimt 
    if ys(i)>1.02*yss 
        ts=t(i); 
    elseif ys(i)<0.98*yss 
        ts=t(i); 
    end 
end 
%上升时间 
for i=1:dimt 
    if ys(i)<0.1*yss; 
        t1=t(i); 
    elseif ys(i)==mp 
        break; 
    end 
end 
for i=1:dimt 
    if ys(i)<0.9*yss; 
        t2=t(i); 
    elseif ys(i)==mp 
        break; 
    end 
end 
tr=t2-t1; 
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实验三   控制系统频域特性分析 

十、 实验目的 

1、加深理解频率特性的概念，掌握系统频率特性的测试原理及方法。 

2、掌握频率特性的Nyquist图和Bode图的组成原理，熟悉典型环节的Nyquist

图和Bode图的特点及其绘制，了解一般系统的的Nyquist图和Bode图的特点和绘制。 

3、了解 MATLAB/SIMULINK，能够根据给出的传递函数运用 MATLAB求出幅相频特

性和对数频率特性。 

十一、 实验设备 
序号 仪器设备名称 数量 

1 计算机 1 

  2         MATLAB软件               1 

  3 打印机              1 

十二、 实验要求 
1、正确理解频率特性的概念，熟悉典型环节的频率特性。 

2、分析开环系统的频率特性，并绘制其开环 Nyquist图和 Bode图，求取剪切频

率ωc，将实验结果与理论分析计算结果进行比较，验证理论的正确性。 

3、分析单位反馈系统的频率特性，并绘制其 Nyquist图和 Bode图，求取谐振频

率ωr、谐振峰值 Mr，将实验结果与理论分析计算结果进行比较，验证理论的正确性。 

4、了解闭环频率特性与时域性能之间的关系。掌握开环增益 K 变化对频率特性

的影响，以及对 Bode图的幅频、相频的影响。 

5、对系统的频率特性进行实验验证，掌握系统频率特性的测试原理及方法。 
6、实验数据、图形曲线、性能指标打印出来。 

 

十三、 实验原理 
1． 频率响应：线性控制系统对正弦输入的稳态响应。也就是说对于这种系统所给
的参考输入信号，只限于正弦函数，而其输出是考虑稳定状态，即当时间 
¥®t 时的情况。 

频 率 特 性 记
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为  
)()(

)(
)()( ωω

ω
ω

ω jGjejG
jR
jYjG Ð==                               

2、幅频特性：正弦输出对正弦输入的幅值比
)(
)()(

ω
ω

ω
jR
jYjG =  

3、相频特性：正弦输出对正弦输入的相移
)(
)()(

ω
ω

ω
jR
jYjG Ð=Ð  

    4、对数频率特性： 

Bode图——对数坐标图，又称 Bode图，它由对数幅频特性图和对数相频特性图

组成。对数幅频特性图纵坐标标度为 )(lg20 ωjG ，其中对数以 10为底均匀分度，采

用单位是分贝(db)；横坐标标度为 ωlg ，以对数分度绘制，标以ω，采用单位是弧度/

秒(rad/s)。对数相频特性图纵坐标为角度，均匀分度，采用单位为度，横坐标与第一张
图完全相同。对数相频特性图放在第一张之下，同时使横坐标的  上下一一对应，以
便对比分析。 

5、极坐标频率特性曲线（又称奈魁斯特曲线） 

它是在复平面上用一条曲线表示ω由 ¥®0 时的频率特性。即用矢量 )( ωjG 的

端点轨迹形成的图形。ω是参变量。在曲线的上的任意一点可以确定实频、虚频、幅
频和相频特性。 

6、利用 MATLAB对控制系统的进行频域特性分析 

（1）求取系统对数频率特性图（波特图）：bode() 

bode(num,den)：可绘制出以连续时间多项式传递函数表示的系统的波特图。 

（2）求取系统奈奎斯特图（幅相曲线图或极坐标图）：nyquist() 

nyquist(num,den)：可绘制出以连续时间多项式传递函数表示的系统的极坐标图。 

nyquist(num,den,w)：可利用指定的角频率矢量绘制出系统的极坐标图。 

（3）常用频域分析函数： 

margin：求幅值裕度和相角裕度及对应的转折频率。 

7、举例说明 

例 1：求典型二阶系统自然振荡频率固定，阻尼比变化时的波特图。 

%求典型二阶系统自然振荡频率固定，阻尼比变化时的波特图 

clear 

close all 

wn=6;% nω  
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kosi=[0.1:0.1:1.0]; %ξ 值 

%在对数空间上生成从 10^(-1)到 10^1共 100个数据的横坐标 

w=logspace(-1,1,100); 

num=wn^2;%分子 

for kos=kosi%对应不同的ξ 值得 

   den=[1 2*kos*wn wn^2]; %分母 

%系统波特图相应的幅值 mag、相角 pha及角频率点 w1矢量 

   [mag,pha,w1]=bode(num,den,w); 

% 注意 mag的单位不是分贝，若需要分贝表示 

% 可以通过 20*log10(mag)进行转换 

   subplot(221); 

   hold on; 

   semilogx(w1,mag)%对应 w1的幅值 

% 注意在所绘制的图形窗口会发现 x轴并没有取对数分度 

   subplot(222) 

   hold on; 

   semilogx(w,mag) %对应 w的幅值 

   grid on 

   subplot(223); 

   hold on; 

   semilogx(w1,pha) %对应 w1的相位 

   subplot(224) 

   hold on; 

   semilogx(w,pha) %对应 w的相位 

   grid on 

end 

subplot(221) 

grid on 

title('bode plot') 

xlabel('frequency(w)') 
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ylabel('amplitude') 

text(6.2,5,'kosi=0.1') 

text(2,0.5,'kosi=1.0') 

subplot(223) 

grid on 

xlabel('frequency(w)') 

ylabel('phase deg') 

text(5,-20,'kosi=0.1') 

text(2,-85,'kosi=1.0') 

hold off 

例 2：已知系统的传递函数为：G(s)=K/(s^3+52s^2+100^s)，求当 K 分别取 1300

和 5200时，系统的极坐标频率特性图 

clear 

close all 

clc 

k1=1300;k2=5200; 

w=8:1:80; %指定角频率矢量 

num1=k1;num2=k2; 

den=[1 52 100 0]; 

figure(1) 

subplot(211) 

%可利用指定的角频率矢量 w绘制出系统的极坐标图 

nyquist(num1,den,w);  

subplot(212) 

pzmap(num1,den);%零极点分布图 

figure(2) 

subplot(211) 

nyquist(num2,den,w); 

subplot(212) 

%可得到系统频率特性函数的实部 re和虚部 im 

[rm,im]=nyquist(num2,den); 
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%用 plot(re,im)绘制出对应 w从负无穷到零变化的部分 

plot(rm,im) 

xlabel('real') 

ylabel('image') 

title('w from 负无穷 to 零') 

figure(3) 

[numc,denc]=cloop(num2,den);%求系统的闭环传函 

subplot(211) 

step(numc,denc) %求闭环传函的阶跃响应 

subplot(212) 

[numc1,denc1]=cloop(num1,den); 

step(numc1,denc1) 

figure(4) 

subplot(211) 

bode(num1,den,w); 

subplot(212) 

bode(num2,den,w); 

十四、 实验内容与步骤 
1、系统的 Bode图                                       图 3-1 

（1）在 MATLAB命令窗口中输入 shiyan3后回车，得到图 3-1所示界面。 

（2）单击 ，出现 Bode响应界面，如图 3-2所示。 

 
图 3-2   Bode响应界面 

分子 

分母 
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传递函数为
01

2
2

3
3

4
4

5
5

01
2

2
3

3
4

4
5

5)(
bSbSbSbSbSb
aSaSaSaSaSaSG
+++++

+++++
= ，其中 S^5、S^4、S^3、S^2、

S^1、S^0分别表示传递函数分子/分母的 5次方项、4次方项、3次方项、2次方项、1

次方项、0次方项（即常数项），S^5等各项前面的文本框代表各项的系数。 

（3）输入分子分母的系数： 

分子部分：在 S^1前面的文本框 中输入 3，然后在 S^0前面的文本框

中输入 4。 

分母部分：在 S^3前面的文本框 中

输入 1，在 S^2前面的文本框 中输入 3，

在 S^1 前面的文本框 中输入 5，然后在

S^0前面的文本框 中输入 7。 

（4）输入分子与分母系数后，                     图 3-3  系统 Bode图 

单击 ，即可得到系统的 Bode 图，

如图 3-3所示。                                               

（5）单击 ，得到系统的谐振峰值、

谐振频率、带宽等性能指标，如图 3-4所示。 

（6）在系统的 Bode图中，单击 即可打印图形。   图 3-4性能指标 

            2、系统的 Nyquist图                   

（1）在“实验三   系统的频率响应”

界面中单击 ，得到图 3-5

所示界面。 

（ 2 ） 分 别 输 入 传 递 函 数

1325
32)( 23 +++

+
=

SSS
SSG 的分子与分母各项的系

数，然后单击 即可得到系统

的 nyquist图，如图 3-6所示。 

图 3-5   Nyquist界面 
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图 3-6   系统 nyquist图 

（3）单击 ，即可得到系统的零极点图 3-7。 

 

图 3-7   系统零极点图 

（4）在系统的 nyquist图中，单击 即可打印图形。 

 

极点 

极点 

极点 零点 

PDF 文件使用 "pdfFactory Pro" 试用版本创建   ÿ   ÿ   www.fineprint.cn

http://www.fineprint.cn


 42

十五、 实验报告要求 
1、单位开环增益变化时对频率特性有何影响？ 

2、什么叫谐振频率ωr，谐振峰值 Mr？根据计算机打印的数据标注在相应的频率

特性图上。 

3、Nyquist图的单位园相当于 bode图上的什么线？ 

4、对于
)2)(1(

8
++

=
SSS

GK
的单位反馈系统。系统会出现谐振？你是如何用实验确

定谐振频率ωr和谐振峰值Mr。 

十六、 思考题 
1、 单位开环增益变化时对频率特性有何影响？ 

1） 分别标注不同 K值Nyquist图上在ω=0时渐近线坐标值，以及曲线与负实

轴的交点频率及坐标值。 

2） Bode图的幅频有何变化？相频有变化吗？ 

2、 什么叫穿越频率ωc，相位裕量γ，相位交界频率ωg及幅值裕度 Kg？按计算机

打印的数据标注在相应的频率特性图上。 

3、 什么叫谐振频率ωr，谐振峰值 Mr？根据计算机打印的数据标注在相应的频率

特性图上。 

4、Nyquist图的单位园相当于 bode图上的什么线？ 

5、对于
)2)(1(

8
++

=
SSS

GK
的单位反馈系统。系统会出现谐振？你是如何用实验确

定谐振频率ωr和谐振峰值Mr。 

十七、 利用MATLAB分析典型系统的频率特性(选做、自学) 

1、典型环节的频率特性测试：利用 MATLAB绘制典型环节的 Bode图与 Nyquist图，掌

握典型环节的频率特性。 

注意： 

grid on：在所画出的图形坐标中加入栅格。 

grid off：在原来加有栅格的图形坐标中取消栅格。 

hold on：使当前图形保持不变，同时允许在这个坐标内绘制另外一个图形。 

hold off：不再允许在同一图形坐标内绘制其他图形。 

grid on与 grid off、hold on与 hold off一般成对出现。 

（1）比例环节 10)( ==KSG  

>>bode(tf(10,[1])),grid on 
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>>nyquist(tf(10,[1])),grid on 

图 3-8  比例环节的 Bode图与 Nyquist图 

（2）积分环节
s

SG 1)( =  

>>bode(tf(1,[1,0])),grid on 

>>nyquist(tf(1,[1,0])),grid on 

图 3-9  积分环节的 Bode图与 Nyquist图 

（3）微分环节 sSG =)(  

>>bode(tf([1,0],1)),grid on 

>>nyquist(tf([1,0],1)),grid on        图 3-10  微分环节的 Bode图与 Nyquist图 
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（4）惯性环节
S

SG
101
1)(
+

=  

>>bode(tf(1,[10,1])),grid on 

>>nyquist(tf(1,[10,1])),grid on 

 
图 3-11  惯性环节的 Bode图与 Nyquist图 

（5）一阶段微分环节 110)( += SSG  

>> bode(tf([10,1],1)),grid on 

>> nyquist(tf([10,1],1)),grid on 

             图 3-12  一阶段微分环节的 Bode图与 Nyquist图 

（6）振荡环节 

①二阶系统
22

2

2
)(

nn

n

SS
SG

ωζω
ω
++

= ，绘制出ς 取不同值时的 Bode图。其中，

nω =6rad/s，ζ 取[0.1：0.1：1]。 

%清除变量和函数 

clear 

 %频率 

wn=6; 
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 %阻尼 

kosi=[0.1:0.1:1];  

%指定频率矢量 

w=logspace(-1,1,100);  

num=[wn.^2];%分子 

%for 循环 

for kos=kosi  

%分母 

den=[1 2*kos*wn wn.^2];  

%求幅值、频率、频率点矢量 

[mag,pha,w1]=bode(num,den,w); %系统波特图相应的幅值 mag、相角 pha 及角频

率点 w矢量 

subplot(2,1,1); 

hold on 

semilogx(w1,mag);%幅频图 

subplot(2,1,2); 

hold on 

semilogx(w1,pha);%相频图 

end%循环结束 

subplot(2,1,1);  

%绘第一图并加上网格 

grid on  

title('Bode Plot');%标题 

xlabel('Frequency(rad/sec)'); 

ylabel('Gain dB') 

subplot(2,1,2),  

%绘第二图并加上网格 

grid on  

xlabel('Frequency(rad/sec)'); 

ylabel('Phase deg'); 

hold off 

图 3-13  二阶系统的 Bode图 

②求 nω =6rad/s，ζ 取[0.1：0.3：1.3]时的 Nyquist图 

wn=6;kosi=[0.1:0.3:1.3];num=[wn.^2]; 

n=length(kosi);%求取向量的长度 

for i=1:n 

den=[1 2*kosi(i)*wn wn.^2];  

hold on 
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nyquist(num,den); 

end 

 

 

 

 

 

 

                          图 3-14  二阶系统的 Nyquist图 

２、分析开环系统
)1001.0)(10025.0)(105.0(

)10167.0(500
+++

+
=

SSSS
SGK 的幅频特性和相频特

性。 

(1)绘图： 

在 MATLAB的命令窗口输入下列命令，绘制系统的 Bode图与 Nyquist图，如图 3-15

所示。 

num=500*[0.0167 1];%分子 

den1=conv([1 0],[0.05 1]); %多项式相乘 S(0.05S+1) 

den2=conv([0.0025 1],[0.001 1]); %多项式相乘(0.0025S+1)(0.001S+1) 

den=conv(den1,den2);%分母 

Go=tf(num,den);%求传递函数 

bode(Go)  

grid on 

figure 

nyquist(Go) 

grid on    

图 3-15  系统的 Bode图与 Nyquist图 

（2）求取相位裕度γ、幅值裕度 Kg等性能指标（要求打印图形并记录下表所要求的数

据）： 
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>>figure 

>>margin(Go) 

该格式用于绘制开环系统的 Bode图，并且用垂直线画出相应的交角频率，显示系

统的稳定裕度数据。 

表 3-1       相位裕度与幅值裕度 

幅值裕度(dB)  相位裕度(deg)  

频率(rad/sec)  频率(rad/sec)  

（3）求系统的增益裕量(Gm)、相位裕量(Pm)、幅值穿越频率 Wcp和相位交界频率 Wcg。 

利用 margin求系统的增益裕量(Gm)、相位裕量(Pm)、幅值穿越频率 Wcp和相位交

界频率 Wcg。 

>>[Gm,Pm,Wcg,Wcp]=margin(Go); 

>>Gm,Pm,Wcg,Wcp 

表 3-2    增益裕量、相位裕量、幅值穿越频率、相位交界频率 

增益裕量(Gm) 相位裕量(Pm) 幅值穿越频率 Wcp 相位交界频率 Wcg 

    

3、分析
)2)(1(

8
++

=
SSS

GK 的单位反馈系统的频率特性： 

(1) 求出系统的闭环传递函数。 

clear 

num=[8]; 

den=[conv(conv([1 0],[1 1]),[1 2])]; 

[nc,dc]=cloop(num,den); 

Gc=tf(nc,dc) 

(2)绘制闭环系统的 Bode图与 Nyquist图，并打印图形。 

>>z=[ ],p=[0  -1  -2],k=[8] 

>>[num,den]=zp2tf(z,p,k) 

>>[nn,dd]=cloop(num,den) 

>>figure ,bode(nn,dd),grid on 

>>figure,nyquist (nn,dd), grid on 

（3）直接获得谐振振幅和谐振频率的方法： 

在频率响应图中，用鼠标右击图中

的空白处，在弹出的快捷键中选择

“ Characteristics”并选中“ Peak 

Response”选项。如图 3-16所示。 

接着会在频率响应图中显示出一

个蓝色圆点标志，鼠标移动到该点就显

示出系统的谐振振幅和谐振频率值。 

图 3-16  直接获得谐振振幅与谐振频率的方法 
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图 3-17     系统的谐振振幅与谐振频率值 

如图 3-18所示，在相频特性图中，用鼠标左键点击特性曲线，会出现手形光标，

在曲线上出现一个方形黑点，并在画面上显示出该点的相位角。只要在空白处单击，就

可取消黑点的显示。 

 

图 3-18     相位角的显示 

（4）在 MATLAB的命令窗口输入下列命令，通过调用函数求出谐振振幅 rM 、相位 rP

和谐振频率 rω ： 

>>G=tf(nn,dd);[Mr,Pr,Wr]=mr(G) 
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调用函数文件 mr.m来求谐振振幅 rM 、相位 rP 和谐振频率 rω  

function  [Mr,Pr,Wr]=mr(G) 

[mag,phase,w]=bode(G);%计算幅值、相位和频率 

mn=mag(1,:);%幅值 

pn=phase(1,:);%相位 

[M,i]=max(mn);%求最大幅值时幅值和相应的下标 i 

Mr=20*log10(M);%谐振振幅  

Pr=pn(1,i);%与谐振振幅对应的相位  

Wr=w(i,1);%谐振频率 

表 3-3     谐振振幅 rM 、相位 rP 与谐振频率 

谐振振幅 rM  相位 rP  谐振频率 rω  

   

(5)改变系统开环增益 K，观察系统频率特性的变化规律； 

通过改变系统开环增益 K，参照前面步骤仅仅改变分子 num,其他保持不变。 
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实验四    控制系统稳定性仿真分析 

十八、 实验目的 
1、运用 Routh稳定判据、Nyquist稳定判据和 Bode稳定判据来判断系统的稳定

性。 

2、研究开环增益 K、时间常数 T对系统的动态性能及稳定性的影响。 

3、学会利用零极点图分析系统的稳定性。 

4、了解相位裕度γ和幅值裕度 Kg与系统的相对稳定性的关系及其规律、以及求

取的方法。 

十九、 实验设备 
序号 仪器设备名称 数量 

1 计算机 1 

  2         MATLAB软件               1 

  3         球杆控制系统              1 

  4 打印机              1 

二十、 实验要求 
1、实验观测记录与响应曲线。 

2、观察开环增益 K对系统的稳定性的影响。 

3、用不同稳定性判据分析系统的稳定性，要求写出判断依据以及推导过程。 

4、分析开环系统的频率特性，并绘制其开环 Nyquist图和 Bode图，求取剪切频

率ωc、相位交界频率ωg、相位裕度γ和幅值裕度 Kg、将实验结果与理论分析计算结果

进行比较，验证理论的正确性。 

5、、掌握剪切频率ωc、相位交界频率ωg与系统的稳定性的关系及其规律、以及

求取的方法。 

6、了解相位裕度γ和幅值裕度 Kg与系统的相对稳定性的关系及其规律、以及求

取的方法。 

7、所做实验要求独立完成。 

二十一、 实验原理 
控制系统的稳定性分析 

(一)系统稳定及最小相位系统判据 1、对于连续时间系统，如果闭环极点全部在 S平面

左半平面，则系统是稳定的。 

2、对于离散时间系统，如果系统全部极点都位于 Z平面的单位圆内，则系统是稳

定的。 

3、若连续时间系统的全部零极点都位于 S左半平面；或若离散时间系统的全部零

极点都位于 Z平面单位圆内，则系统是最小相位系统。 

(二)系统稳定及最小相位系统的判别方法 
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1、间接判别（工程方法） 

劳斯判据：劳斯表中第一列各值严格为正，则系统稳定，如果劳斯表第一列中出

现小于零的数值，系统不稳定。 
胡尔维茨判据：当且仅当由系统分母多项式构成的胡尔维茨矩阵为正定矩阵时，

系统稳定。2、直接判别 

MATLAB提供了直接求取系统所有零极点的函数，因此可以直接根据零极点的分布

情况对系统的稳定性及是否为最小相位系统进行判断。 

3、对数稳定性判据 

控制系统开环频率特性函数的极坐标图和对数频率特性图之间有如下的对应关

系：极坐标图上以原点为圆心的单位圆对应于对数频率特性图的 0分贝线；极坐标图的

负实轴对应于相频特性的
0180- 。 

对数判据之一：对于开环稳定的系统，如果系统开环对数幅频特性 )(ωL 穿过 0

分贝线时，对应的相频特性相角大于
0180- ，则闭环系统稳定；否则闭环系统不稳定。 

对数判据之二：对于开环稳定的系统，闭环系统稳定的充要条件是——在开环对

数幅频特性 )(ωL >0的所有频段内，其对数相频特性 )(ωϕ 对
0180- 线的正负穿越次数

之差为 0。如果系统在右半 S 平面有 P 个开环极点，则开环稳定的系统的充要条件是

)(ωL >0的所有频段内， )(ωϕ 对
0180- 线的正负穿越次数之差为 P/2。 

4、奈氏稳定性判据 

(1)对于开环稳定的系统，闭环系统稳定的充要条件是系统开环频率特性函数的奈

氏图不包围复平面的 )0,1( j- 点； 

(2)设开环不稳定的系统在右半 S平面有 P个开环极点，闭环系统稳定的充要条件

是当ω由 ¥- 变为 ¥+ 时，开环频率特性函数的奈氏图逆时针包围 )0,1( j- 点 P次。 

二十二、 实验内容与步骤 

（一）分析系统
P

P

CKS
CK

S
SxSG

+
== 2)(

)()(
θ

（令 C=1）的稳定性。  

1、用劳斯判据分析系统稳定的条件（要求实验前算出系统稳定时 PK 值的范围）：系

统的特征方程是 0)( 2 =+= PKSSD 。 

由劳斯判据可知，该系统不稳定，具有两个虚根： PKiS =1 和 PKiS -=2 。 
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2、根据Nyquist图和Bode图利用Nyquist 判据和Bode判据分析系统稳定条件。 

（1）在 MATLAB命令窗口中输入 shiyan4后回车，得到图 4-1所示的界面。 

图 4-1                             图 4-2 

（2）单击 ,得到图 4-2所示的界面。 

（3）分别输入传递函数
P

P

KS
KSG
+

= 2)( 分子的系数 5与分母的系数(1,0,5)，然

后单击 ，得到系统的 Bode图，如图 4-3所示。此时，可利用 Bode判据判断

系统的稳定性。 

单击 ，得到系

统的性能指标。如图 4-4所表

示。 

 

 

 

 

 

 

 

 

图 4-4  性能指标                         图 4-3  

系统 Bode图 

（3）在“实验四  系统的稳定性” 界面中，单击

,得到图 4-5所示的界面。 

输入传递函数分子、分母的系数后 5与（1，0，5），

单击 ，即得系统的 Nyquist图，                           图 4-5 
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利用 Nyquist判据判断系统的稳定性。 

（4）在“实验四  系统的稳定性” 界面中，单击 ,得到图 4-6

所示的界面。 

 
图 4-6 

输入传函分子、分母的系数 5与（1，0，5）后，单击 ，即得传递

函数的零极点分布图 4-7。 

单击 ，得到传递函

数的零极点，见图 4-8。 

 

 

 

 

 

 

 

 

图 4-7  零极点分布图                          图 4-8  零极点分布图 

（5）在“实验四  系统的稳定性” 界面中，

单击 ,得到图 4-9所示的界面。 

 

 

输入传递函数分子、分母的系数 5与（1，0，

5）后，单击 ，即得系统的阶跃响

应图,从输出响应曲线判断系统的稳定性。                 图 4-9 
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单击 ，得到系统阶跃响应的

性能指标，见图 4-10。 

 

3、 利用 IPM Motion Studio软件分析 

（1）进入 IPM Motion Studio界面，见图 4-11。 

            

图 4-10   性能指标 

 

 

 

图 4-11   性能指标 

 

 

 

（2）选择工具栏上的“Project”→“Open”。 

在弹出“Open Project”窗口，见图 4-12，选择“BallBeamEng.msa”,然后单

击打开，得到“Technosoft IPM Motion Studio-Project BalllBeamEng”界面，见图

4-13。 

  

图 4-12   

       
图 4-13 
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（3）在“Technosoft IPM Motion Studio-Project BalllBeamEng”界面中，选

择工具栏上的“View” →“Project” ，弹出“Project”窗口，见图 4-14。 

    

图 4-13 

（ 4 ） 弹 出

“ Project”窗口

后，选择工具栏上

的 ，使球杆系统

动作。然后单击工

具栏上的 ，弹出

“ Ball and Beam 

System”窗口。见

图 4-14。 

                图 4-14 

（5）在弹出“Ball and Beam System”窗口中，

右击，在弹出的快捷菜单中，选择“Start”。调节

Kp=5,Ki=Kd=0，观察响应曲线。见图 4-15。 

（二）分析系统
CSKS

SKC
S
SxSG

d

d

++

+
== 2

)1(
)(
)()(

θ
（令

C=1, dK =3, 1=Kp ）的稳定性。                                          

图 4-15 

1、用劳斯判据分析系统稳定的条件（要求实验前算出系统稳定时 dK 值的范围）：系

统的特征方程是 01)( 2 =++= SKSSD d 。 

2、根据Nyquist图和Bode图利用 

Nyquist 判据和Bode判据分析系统稳定条件。                 

（1）在 MATLAB命令窗口中输入 shiyan4后回车，得到图 4-16所示的界面。 
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（2）单击 ,得到图 4-17所

示的界面。 

 

 

 

 

图 4-16 

 

（ 3 ） 分 别 输 入 传 递 函 数

1
1)( 2 ++

+
=

SKS
SKSG

d

d 分子的系数（3，1）与分 

图 4-17 

母的系数(1,3,1)，然后单击 ，得到系统的 Bode图。

此时，可利用 Bode判据判断系统的稳定性。 

单击 ，得到系统的性能指标。如图 4-18 所表

示。 

                                                    

（ 3）在“实验四   系统的稳定性”  界面中，单击

,得到图 4-19所示的界面。                         图 4-18 

         输入传递函数分子、分母的系数后（3，

1）与（1，3，1），单击 ，即得

系统的 Nyquist图，利用 Nyquist判据判断系统

的稳定性。 

图 4-19 

（4）在“实验四  系统的稳定性” 

界面中，单击 ,得到图

4-20所示的界面。                                             

 

 

图 4-20 
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输入传函分子、分母的系数（3，1）与（1，3，1）后，单击 ，即

得传递函数的零极点分布图，见图 4-21。 

单击 ，得到传递函数的

零极点，见图 4-22。 

 

图 4-21                                    图 4-22 

（5）在“实验四  系统的稳定性” 

界面中，单击 ,得到图

4-23所示的界面。 

 

输入传递函数分子、分母的系数

（ 3， 1）与（ 1， 3， 1）后，单击

，即得系统的阶跃响

应图。                                         图 4-23 

单击 ，得到系统阶跃响应的性能指标，见图

4-24。 

 

3、 利用 IPM Motion Studio软件分析 

在弹出“Ball and Beam System”窗口中，调节 Kp=3,Ki=0，

Kd=1，观察响应曲线。 

 

（三）分析系统

)1(

)1(
)(

2

S
KSKCKS

S
KSKCK

SG
i

dP

i
dP

+++

++
=                   图 4-24 

（ 令 C=1 ， 2=PK ， 1=dK ， 05.0=iK ） 的 稳 定 性 。 
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122
122

)(
)()( 23

2

23

2

+++

++
=

+++

++
=

SSS
SS

KSSKKS
KSSKKSG

idP

idP  

1、用劳斯判据分析系统稳定的条件（要求实验前算出系统稳定时 dK 值的范围）：  

2、根据Nyquist图和Bode图利用Nyquist 判据和Bode判据分析系统稳定条件。 

（1）利用 Bode图判断系统稳定性： 

输入传递函数分子分母的系数，见图 4-25。 

单击 ，得到系统的

Bode 图。此时，可利用 Bode 判据判

断系统的稳定性。见图 4-26。 

图 4-25 

图 4-26 

单击 ，得到系统的性能指标，见图 4-27。 

 

（2）利用 Nyquist图判断系统的稳定性： 

输入传递函数分子、分母的系数后（2，2，1）与（1，2，2，

1），得到系统的 Nyquist图，见图 4-28。 

图 4-27 

                                   

 

图 4-28 
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（3）利用零极点图判断系统稳定性： 

输入传函分子、分母的系数（2，2，1）与（1，2，2，1），得到零极点分布图，

见图 4-29。 

单击 ，得到传递函数

的零极点，见图

4-30。 

 

 

 

 

 

 

 

图 4-29                                           图 4-30 

（4）利用系统阶跃响应判断系统稳定性： 

输入传递函数分子、分母的系数（2，2，1）与（1，2，2，1），得到系统的阶跃

响应图。 

单击 ，得到系统阶跃响应的性能指标，见图 4-31。 

 

图 4-31 

 3、 利用 IPM Motion Studio软件分析 

在弹出“Ball and Beam System”窗口中，调节 Kp=2,Ki=1，Kd=0.05，观察响应

曲线。 

二十三、 实验报告要求 
1、用三种稳定判据判别系统的稳定性。 

2、实验记录与响应曲线。 

3、叙述振荡环节中阻尼系数对环节的影响。 

4、结合实验遇到的问题谈谈对实验的看法，对实验现象进行分析讨论，写出本
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实验的心得与体会。 

5、根据测得的系统单位阶跃响应曲线，分析开环增益 K对系统稳定性的影响。 

二十四、 思考题 
1、影响二阶系统动态性能的两个主要参数是什么？二阶系统在什么条件下，其

瞬态响应处于要振不振的临界状态？ 

2、在典型二阶系统中，改变增益对系统的动态性能有何影响？阻尼比对系统的

动态性能有何影响？  

3、什么叫穿越频率ωc，相位裕量γ，相位交界频率ωg及幅值裕度 Kg？按计算机

打印的数据标注在相应的频率特性图上。 

4、三阶系统中，为使系统能稳定工作，开环增益 K应适量取大还是取小？ 

八、用 Matlab程序分析系统稳定性 (选做、自学) 

1、根据Nyquist图和Bode图利用Nyquist 判据和Bode判据分析系统稳定条件。 

（1）列出系统的闭环传递函数
210

2
210

3
210

21

)(
)(

KKSTSTTTSTTT
KKSG

++++
= 。 

（2）令 K= 21KK , 0T =1， 1T =0.1， 2T =0.51，根据闭环系统的特征多项式求其特

征根判断系统的稳定性。令 K=0.86,11.96,15,根据特征根的分布判断稳定性。 

t0=1; 

t1=0.1; 

t2=0.51 

k=0.86 

t0=1; 

t1=0.1; 

t2=0.51 

k=11.96 

t0=1; 

t1=0.1; 

t2=0.51 

k=15 

den=[t0*t1*t2,t0*(t1+t2),t0,k];% 闭环特征多项式 

p=roots(den)%求其特征根 

（3）绘制开环系统的Nyquist图和Bode图，分别用 Nyquist 判据和Bode判
据判断系统的稳定性。 

参照下列程序代码，分别修改 K=0.86,11.96,15, 绘制并打印 Nyquist 图和

Bode图，根据 Nyquist 稳定判据以及Bode稳定判据判断稳定性。要求写出推导
过程。 

clear 

t0=1,t1=0.1,t2=0.51,k=0.86 

num=[k] 

den=[t0*t1*t2,t0*(t1+t2),t0,0] 
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G=tf(num,den) 

figure,bode(G),grid on 

figure,nyquist(G),grid on 
2、利用系统的单位阶跃响应分析稳定性 

（1）建立该系统的阶跃响应模型，见图 4-32。 
 

 

 

 

   

图 4-32 

（2）分别改变开环增益 K，运行仿真，观察系统阶跃响应曲线，分析稳定性。 

开环增益 K1 K2 输出稳定性 

15 3 5  

11.96 4 2.99  

8 2 4  

（3）分别改变系统的时间常数，见图 4-33。运行仿真，观察系统 

阶跃响应曲线，分析稳

定性。 

 

 

图 4-33 

（4）如果图形显示得不够充分，可以通过修改仿真时间来调节 x轴的范围。 

选择菜单 Simulation→Simulation parameters→出现 Simulation parameters对话框

→修改 Stop times。 
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实验五   控制系统校正及 PID控制器仿真 

一、实验目的 

1、熟悉超前、滞后和超前——滞后网络的特性。 

2、理解基于频率法进行串联校正的基本概念，掌握基于频率法进行超前、滞后

和超前——滞后校正的方法。 

3、了解控制系统的设计和校正原理，给定原系统，能分析出系统参数，设计串

联校正装置，使系统满足一定性能指标，观察校正前后系统动态特性的变化,了解校正

装置对系统性能的影响，掌握控制系统分析和校正方法。 

4、掌握 P、PD、PID 控制器的控制原理和实际应用，及对球杆系统的控制效果。 

5、了解在 Matlab Simulink 环境下进行实时控制的原理和方法。 

二、实验设备 

序号 仪器设备名称 数量 

1 计算机 1 

  2         MATLAB软件               1 

  3        球杆控制系统              1 

  4 打印机              1 

三、 实验原理 

（一）基本概念 

1、校正：就是在系统中加入一些其参数可以根据需要而改变的机构或装置，使系统整

个特性发生变化，从而满足给定的各项性能指标。 

2、校正方式：串联校正、反馈校正、前馈校正、复合校正。 

3、常用的校正方法：有根轨迹法和频率特性法 

（二）基本控制规律 

1、比例（P）控制规律         )()( teKtm p=  

提高系统开环增益，减小系统稳态误差，但会降低系统的相对稳定性。 

2、比例-微分（PD）控制规律   
dt

tdeKteKtm pp
)()()( τ+=  

PD控制规律中的微分控制规律能反映输入信号的变化趋势，产生有效的早期修正

信号，以增加系统的阻尼程度，从而改善系统的稳定性。在串联校正时，可使系统增加
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一个
τ
1
- 的开环零点，使系统的相角裕度提高，因此有助于系统动态性能的改善。 

3、积分（I）控制规律     dtteKtm t
i )()( 0ò=  

具有积分（I）控制规律的控制器，称为 I控制器。 

输出信号 )(tm 与其输入信号的积分成比例。 

iK 为可调比例系数,当 )(te 消失后，输出信号 )(tm 有可能是一个不为零的常量。 

在串联校正中，采用 I控制器可以提高系统的型别（无差度），有利提高系统稳态

性能，但积分控制增加了一个位于原点的开环极点，使信号产生
090 的相角滞后，于系

统的稳定不利。不宜采用单一的 I控制器。  

4、比例-积分（PI）控制规律     dtte
T
K

teKtm t

i

p
p )()()( 0ò+=  

具有积分比例-积分控制规律的控制器，称为 PI控制器。 

输出信号 )(tm 同时与其输入信号及输入信号的积分成比例 

pK 为可调比例系数 

iT 为可调积分时间系数 

开环极点，提高型别，减小稳态误差。 

右半平面的开环零点，提高系统的阻尼程度，缓和 PI极点对系统产生的不利影响。

只要积分时间常数 iT  足够大，PI控制器对系统的不利影响可大为减小。 

PI控制器主要用来改善控制系统的稳态性能。 

5、比例（PID）控制规律 

具有比例-积分-微分控制规律的控制器，称为 PID控制器。 

dt
tdeKdtte

T
K

teKtm p
t

i

p
p

)()()()( 0 τ++= ò  

S
SS

T
K

S
STST

T
K

S
ST

KSG
i

pii

i

p

i
pc

)1)(1(
)

1
()11()( 21

2 ++
=

++
=++=

τττ
τ  
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如果
iT

τ4
<1    )411(

2
1

1
i

i T
T τ

τ -+=     )411(
2
1

2
i

i T
T τ

τ --=  

（三）频率法串联校正设计 

1、 频率法对系统进行校正的基本思路是：通过所加校正装置，改变系统开

环频率特性的形状，即要求校正后系统的开环频率特性具有如下特点： 

l 低频段的赠以满足稳态精度的要求； 

l 中频段的幅频特性的斜率为-20dB/dec,并具有较宽的频带，这一要求是为了

系统具有满意的动态性能； 

l 高频段要求幅值迅速衰减，以较少噪声的影响。 

2、频率法串联超前校正设计 

（1）用频率法对系统进行超前校正的基本原理，是利用超前校正网络的相位超前

特性来增大系统的相位裕量，以达到改善系统瞬态响应的目点。为此，要求校正网络最

大的相位超前角出现在系统的截止频率（剪切频率）处。串联超前补偿网络传递函数为

TS
TSSGc +

+
=

1
1)( α

, 1>α 。 

（2）用频率法对系统进行串联超前校正的一般步骤可归纳为：根据稳态误差的

要求，确定开环增益 K。根据所确定的开环增益 K，画出未校正系统的波特图，计算未

校正系统的相角裕度γ 。 

l 由给定的相位裕量值 ''γ 计算超前校正装置提供的相位超前量

εγγϕϕ +-== ''
m  

l ε 是用于补偿因超前校正装置的引入，使系统截止频率增大而增加的相角滞
后量。 

l ε 值通常是这样估计的：如果未校正系统的开环对数幅频特性在截止频率处

的斜率为-40dB/dec，一般取
00 10~5=ε ；如果为-60dB/dec则取

00 20~15=ε 。 

l 根据所确定的最大相位超前角 mϕ ，按
m

m

ϕ
ϕ

α
sin1
sin1
-

+
= 算出α 值。 

公 式 回 顾    
a
a

a
aarctgm +

-
=

-
=

1
1arcsin

2
1

ϕ    
aTm

1
=ω    

aTS
TSSGc +

+
=

1
1)(  

l 计算校正装置在 mω 处的幅值 α/1lg    

)/1lg(10/1lg20)( aaL mc ==ω  
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由未校正系统的对数幅频特性曲线，求得其幅值为- α/1lg 处的频率，该频率 mω

就是校正后系统的开环截止频率
''ω 即 mω =

''ω 。 

l 确定校正网络的转折频率 1ω 和 2ω ，
α

ω
ω m=1 ， αωω m=2 。画出校正

后系统的波特土，并演算相位裕度时候满足要求？如果不满足，则需增大ε 值，从前面

开始重新进行计算，  

3、频率法串联滞后校正设计 

滞后补偿网络的传递函数为
TS
TSSGc +

+
=

1
1)( β

， 1<β 。 

串联滞后校正的设计步骤如下： 

l 根据稳态误差要求确定开环增益 K。 

l 根据已确定的开环增益 K，绘制未补偿系统开环传递函数 )(0 SG 的对数坐标

图。 

l 如果未补偿系统不满足设计要求，则在对数相频特性上找一点 cω ， cω 满足

条件 )125(180)( 000
0 -++-=Ð γωcjG ，其中γ 是所要求的相位裕度， )12~5( 00

是补偿引入滞后网络产生的附加相角滞后， cω 是补偿后系统的截止频率。 

l 在未补偿系统的开环对数幅频特性上，在频率 cωω = 处，量出

)(lg20 0 cjG ω 的数值，再令 )(lg20lg20 0 cjG ωβ -= ，由此解出参数β 。 

l 为使串联滞后网络在 cω 处产生的滞后角处于 )125( 00 - 的范围内，取

cω
β

)2.0~1.0(1
» 解出 T，这样滞后网络参数β 、T 全部确定。 

l 绘制已补偿系统的对数坐标图，检验幅值裕度。 

4．频率法串联超前——滞后校正设计 

串联滞后-超前校正的设计步骤如下：根据稳态性能要求，确定开环增益 K 

l 绘制未校正系统的对数幅频特性，求出未校正系统的截止频率 cω 、相位裕度
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γ 及幅值裕度 )(dBh 等 

l 在未校正系统对数幅频特性上，选择斜率从-20dB/dec 变为-40dB/dec 的转

折频率作为校正网络超前部分的转折频率 bω  

l 根据响应速度要求，选择系统的截止频率 ''
cω  

和校正网络的衰减因子
β
1

 

要保证已校正系统截止频率为所选的
''

cω  

下列等式应成立： 0lg20)(lg20 ''
2

''' =++- cc TL ωωβ  

求出β 值。 

l 根据相角裕度要求，估算校正网络滞后部分的转折频率 2ω  

l 校验已校正系统开环系统的各项性能指标 

（四）球杆控制系统 

1、 球杆控制系统简介  

球杆系统（Ball & Beam）是为自动控制原理等基础控制课程的教学实验而设计

的实验设备。该整个装置由球杆执行系统、控制器和直流电源等部分组成。 

球杆执行系统（如图1所示）由一根V型轨道和一个不锈钢球组成。V型槽轨道一

侧为不锈钢杆，另一侧为直线位移电阻器。当球在轨道上滚动时，通过测量不锈钢杆上

输出电压可测得球在轨道上的位置。V型槽轨道的一端固定，而另一端则由直流电机（DC 

motor）的经过两级齿轮减速，再通过固定在大齿轮上的连杆带动进行上下往复运动。V

型槽轨道与水平线的夹角可通过测量大齿轮转动角度和简单的几何计算获得。这样，通

过设计一个反馈控制系统调节直流电机的转动，就可以控制小球在轨道上的位置。  

GBB1004型球杆系统由三大部分组成：IPM100智能驱动器、球杆装置和控制计算

机。IPM100智能驱动器使用方法请参照《IPM100SK用户手册》；计算机为装有Windows

的计算机或是其他兼容机。本实验说明主要讲述球杆装置、控制软件及实验.  
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Ball and Beam系统如图5-1所示：  

 

图5-1 

在一长约0.4米的轨道上放置一不锈钢球，轨道的一侧为不锈钢杆，另一侧为直

线位移传感器，当球在轨道上滚动时，通过测量不锈钢杆上输出的电压信号可获得球在

轨道上的位置x。电机转动带动齿轮系驱动杠杆臂Lever Arm转动，轨道Beam随杠杆臂的

转动与水平方向也有一偏角α,球的重力分量会使它沿着轨道滚动，设计一个控制系统

通过调节伺服角度θ使得不锈钢球在Beam上的位置能被控制。  

此系统为一个单输入（电机转角θ）、单输出（小球位置）系统，输入量θ利用

伺服电机自带角度编码器来测量，输出量x由轨道上电位器的电压信号来获得。系统组

成框图如图5-2下：  

 

图5-2 

系统包括计算机、IPM100智能伺服驱动器、球杆本体和光电码盘、线性传感器几

大部分，组成了一个闭环系统。光电码盘将杠杆臂与水平方向的夹角、角速度信号反馈

给IPM100智能伺服驱动器，小球的位移、速度信号由直线位移传感器反馈。智能伺服控

制器可以通过RS232接口和计算机通讯，利用鼠标或键盘可以输入小球的控制位置和控
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制参数，通过控制决策计算输出（电机转动方向、转动速度、加速度等），并由IPM100

智能伺服驱动器来实现该控制决策，产生相应的控制量，使电机转动，带动杠杆臂运动，

使球的位置得到控制。  

2、球杆系统的建模分析 

使小球在导轨上加速滚动的力是小球的重力在同导轨平行方向上的分力同小球受

到的摩擦力的合力。考虑小球滚动的动力学方程，小球在 V型杆上滚动的加速度： 

ααµ sincos gga -=          

其中µ为小球与轨道之间的摩擦系数，而α 为轨道杆与水平面之间的夹角。 

在进行数学建模的过程中，我们忽略了摩擦力，因此，其基本的数学模型转换如

下公式： 

mamg =αsin                   

当 1<<α 时，将上式线性化，得到传递函数如下： 

2)(
)(

S
g

S
Sx
=

α                        

其中 )( Sx 为小球在轨道的位置。 

但是，在实际控制过程中，杆的仰角α 是由电动机的转角输出来实现的。影响电

动机转角θ 和杆仰角α 之间关系的主要因素就是齿轮的减速比和非线性。因此，我们

把该模型进一步简化： 

)()( SbS αθ ·=                           

把 )()( SbS αθ ·= 代入 2)(
)(

S
g

S
Sx
=

α ，我们可以得到另一个模型

2)(
)(

S
C

S
Sx
=

θ
                                 

其中 C是一个包含了 b和 g的影响的参数。 

因此，球杆系统实际上可以简化为一个二阶系统。此系统是一单输入输出控制系

统，当给定小球的一个位置时，输入角度θ 的改变可使输出量——小球在轨道上的位

置得到控制。 
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四、实验内容与步骤 

（一）超前校正网络设计：设球杆控制系统的传递函数
2

1)(
S

SG = 。若要求校正后

系统的相位裕度不小于
050 ，幅值裕度为 ¥+ dB,试求系统的校正装置。 

1、确定系统需要增加的相位超前角

ϕ，绘制放大倍数 K=1的未校正系统的开

环对数频率特性，并求出相角裕度和幅值

裕度。作
2

1)(
S

SG = 的波特图，见图 5-3。 

由图求出系统截止频率
/
cω 和系统

的相角裕度与幅值裕度。选择校正装置

（建议选用超前校正装置）。 

2、确定系统需要增加的相位超前角

ϕ：由于加入超前校正装置后，                           图 5-3 

对数幅频特性向右移动，为补偿由此造成的相角滞后，要在相角裕度上加以修正，

取
05=D 。由系统要求的相角裕度和原系统相角裕度。求需要的最大相位超前角 

D+-= )( '''
cm ωγγϕ  

根据
m

m

ϕ
ϕ

α
sin1
sin1
-

+
=  

求得α  

3、在未校正系统的对数幅频特性上计算其幅值等于-10lgα 所对应的频率就是校

正后系统的截止频率
''

cω ，且
''

cω = mω 。在 mω 点上未校正系统的对数幅频特性幅值为 

αωω lg10)()( ''' ==- mcc LL  

求出其对应的频率： mc ωω =''
。 

4、确定超前网络参数α 和 T：由于
αωm

T 1
= ，根据计算得出的超前网络参数α

和 T，可确定超前网络的传递函数 Gc(s); 
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5、验证校正系统的相角裕度
''γ ：超前网络参数确定后，求出已校正系统开环传

递函数 

)()()( SGSGsG ck ×=  

求出其波特图，由 Bode图的相频特性曲线查得
''

cω = mω 时系统的相角裕度、幅

值裕度，验证全部性能指标是否满足要求。 

（二）利用固高实时控制软件分析 

1、先接通固高球杆系统的电源。 

2、先进入 MATLAB，然后修改工作路径到固高实时控制软件所在的位置——MATLAB

安装路径\toolbox\GoogolTech，见图 5-4。 

 

图 5-4 

接着进入 Simulink，见图 5-5。 

 

图 5-5 
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3、在 Simulink库中，选择并展开 Googol Education Products，见图 5-6所示。 

 

图 5-6 

4、双击上图右边的 球杆 PID 控制模块。弹出

一个个窗口——BallBeam，见图 5-7。 

 

图 5-7 

5、 在 上 图 所 示 的 窗 口 中 ， 点 击 ， 系 统 开 始 运 行 。 此 时 ，

变成 ，窗口下面的状态栏也发生变化，
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显示仿真时间与进程 ，具体见图 5-8。 

 

图 5-8 

6、双击模型中的 Start Real Control模块 ，弹出 BallBeam/Start 

Real Control窗口，见图 5-9。 

 

 

图 5-9 
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7、在 BallBeam/Start Real Control窗口中，双击左上角的参考位置模块 ，就

可以修改球的参考位置（即理想位

置。） 

8 、 在 BallBeam/Start Real 

Control窗口中，双击 PID控制器模块

，弹出 BlockParameters 模

块参数框。其中，Kp是 P控制器系数、

Ki 是 I 控制器系数、Kd是 D 控制器

系数、SampleTime是采样时间。修改

各个参数后，点 OK即可。见图 5-10。                          图 5-10 

9、双击 Scope模块，见图 5-11，观察响应曲线。 

 

图 5-11 

五、实验报告要求 

1． 实验目的，实验原理及数据。 

2． 说明各校正装置的作用，画出各校正的幅相频特性。 

3．对实验现象进行分析讨论 。 

六、思考题 

1、试说明 PD、PI和 PID控制器各适用于什么场合？它们各有什么优、缺点？ 

2、为什么由实验得到的 PD和 PID输出波形与它们的理想波形有很大的不同？ 

3、加入超前校正装置后，为什么系统的瞬态响应会快？ 
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4、什么是超前校正装置和滞后校正装置，它们各利用校正装置的什么特性对系统

进行校正？ 

5、在什么情况下加滞后校正环节能提高系统稳定性？ 

6、设计系统时，阻尼比、超调量、谐振峰值、相角裕度和幅值裕度，一般应取多

大比较合适？ 
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